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DX8000 PC Client Application

DX8000 PC Client Software

DESCRIPTION
The DX8000 PC Client application allows operators and DVRs to be geographically dispersed. Up to five DVR servers can be actively viewed from 
a single PC client. Up to 50 DX8000 server sites can be added to the Connection List. For more information on the connection kit, refer to          
Connecting to the DX8000 DVR Server Sites on page 22. 

The PC Client application facilitates 

• Remote viewing of live and playback video

• Index, thumbnail, and pixel searching

• Exporting to a variety of media and formats

• Printing still images from video 

• Limited remote control and administration 

RECOMMENDED SYSTEM REQUIREMENTS
Minimum recommended system requirements for the DX8000 PC Client, Emergency Agent, and Native Viewer software applications include

• Processor: Intel® Pentium® III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB of video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX® 8.1 or later hardware 
acceleration

• 500 MB of free disk space

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows® 2000 (SP4) or Windows XP only

INSTALLING THE PC CLIENT APPLICATION
1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8000 Resource CD into the CD-ROM drive of your PC and wait for the DX8000 Resource CD screen to appear.
C626M-B (3/05) 13DX8000 PC Client Application



            
Figure 1.  Resource CD Screen: PC Client Installation Option

4. Click “PC Client Software.” The DX8000 Security Setup dialog box opens.

Figure 2.  DX8000 Security Setup Dialog Box

5. Verify that the “Install IPSec Configurations” check box is selected.

6. Click Next. The DX8000 Client Setup dialog box opens.

Figure 3.  DX8000 PC Client Setup Dialog Box

IMPORTANT:  IPSec is a standard security protocol used by the DX8000 Series DVR and its clients to communicate safely over a network. 
Although IPSec security can be disabled at any time, it must be enabled in order to communicate with a DX8000 server.
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7. Click Next. The Software License Agreement dialog box opens.

Figure 4.  PC Client Software License Agreement Dialog Box

8. Read the license agreement and select the “I accept this License Agreement” check box.

9. Click Next. The Select Installation Folder dialog box opens.

Figure 5.  PC Client Select Installation Folder Dialog Box

10.  Click Next to accept the default installation folder. 
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Figure 6.  PC Client Installation Finalization Dialog Box

11. Click Finish to complete the installation process.

ENABLING IPSEC SECURITY SERVICES
In order to communicate with a networked DX8000 Series DVR, IPSec security must be enabled on your PC computer. 

To enable IPSec security services:

1. Go to Start > Manage IPSec Policy. The DX8000 IPSec Policy dialog box opens.

Figure 7.  Enabling IPSec Security for the PC Client Application

2. Select the Enable DX8000 IPSec Policy check box if it is not already selected.

DISABLING IPSEC SECURITY SERVICES
To disable IPSec security services:

1. Go to Start > Manage IPSec Policy. The DX8000 IPSec Policy dialog box opens.

Figure 8.  Enabling IPSec Security for the PC Client Application

2. De-select the Enable DX8000 IPSec Policy check box.

IMPORTANT:  Disabling IPSec security services may hamper your PC’s ability to communicate with DX8000 servers. Consult your system 
administrator before disabling IPSec security.
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Before You Begin
Ensure that the following requirements have been met before starting the PC Client application:

1. Make sure there is at least one active DX8000 Series DVR available on your network and your PC computer is set up to access it. Consult 
your network administrator for more information.

2. Install the DX8000 PC Client application on your PC computer if you have not done so already. Refer to Installing the PC Client Application 
on page 13 for instructions.

3. Make sure you have a valid, active account on the DX8000 DVR server you want to access. Consult your system administrator if you have 
not been assigned a DX8000 user name and password.

4. Make sure IPSec security services are installed and enabled on your PC. Refer to Installing the PC Client Application on page 13 and 
Enabling IPSec Security Services on page 16 for more information.
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Starting the DX8000 PC Client Application
To start the DX8000 Client Application, double-click the DX8000 Client icon on your desktop.

AUTOMATIC SYSTEM UPGRADE

 

Figure 9.   Client Upgrade Notice

To check the current version of software, go to Help > About.

IMPORTANT:  To avoid potential problems and conflicts within your computer’s video subsystem, run only one instance of the PC Client 
application at a time.

NOTE:  Each time the PC Client application starts, the system will check the network to see if there is a newer version of the software 
available for upgrade. If a new version is found, a message screen like the one in Figure 9 will appear. When this screen appears, click Yes 
and the DX8000 PC Client software will automatically download the upgrade files, install them, and restart your computer.
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PC Client Application Log-In
To access the DX8000 PC Client application, enter a valid password in the “Input password” text box.

Figure 10.  DX8000 Client Password Dialog Box

To change the DX8000 Client password:

1. Wait while the software loads and the main screen appears.

Figure 11.  DX8000 PC Client Application Main Screen

NOTE:  The default password for the DX8000 PC Client application is “000000.” You should change the client password immediately after 
logging in to the software for the first time. Follow the instructions below to change the client application log-in password.
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2. Go to File > Client Password. The DX8000 Client Password Setup dialog box opens.

Figure 12.  DX8000 Client Password Setup Dialog Box

3. Enter the old password in the “Old password” text box.

4. Enter a new password in the “New password” text box.

5. Re-enter the new password in the “Confirm” text box.

6. Click OK.

TIP:  Remember the new client password or write it down and store it in a secure location.

�
�
�

�
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Enabling DirectDraw Video Hardware Acceleration
If your computer’s video hardware supports Microsoft® DirectDraw® extensions, you can enable DirectDraw to enhance video performance. 
Enabling DirectDraw improves performance by delegating graphics acceleration duties to your PC’s video hardware instead of your computer’s 
main processor.

To enable DirectDraw hardware  acceleration, go to View > DirectX Draw.

Figure 13.  View Menu DirectDraw Option

WARNING:  Do not enable DirectDraw on the PC Client application unless you are certain that your hardware supports DirectDraw hard-
ware acceleration. Check the documentation that came with your PC and your graphics card before enabling DirectDraw. Although some 
VGA cards support DirectDraw, not all are compatible with the DX8000 PC Client application. Check the Pelco Web site for a complete list 
of compatible VGA cards.
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Connecting to DX8000 DVR Server Sites

ADDING A DX8000 DVR SERVER TO THE CONNECTION LIST
The DX8000 PC Client application allows operators and DVRs to be geographically dispersed. Up to five DVR servers can be actively viewed from 
a single PC client. Up to 50 DX8000 server sites can be added to the Connection List. 

The PC Client application facilitates 

• Remote viewing of live and playback video

• Index, thumbnail, and pixel searching

• Exporting to a variety of media and formats

• Printing still images from video 

• Limited remote control and administration 

To add a site to the Connection List when you know the site’s IP address:

1. Click . The Connection List dialog box opens.

Figure 14.  Connection List Dialog Box

2. Click Add. The Server Information dialog box opens.

Figure 15.  Server Information Dialog Box

3. Enter the name of the DX8000 Series DVR you wish to connect to.

4. Enter the IP address of the DVR.

5. If necessary enter a new base port number (9002 is the default).

NOTE:  Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, 
but are protected from external threats by a firewall. Client and server ports must be identical.

�
�
�
�

�
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6. If necessary enter a software upgrade port number (9003 is the default).

7. Click OK. The site appears in the Connection List.

To add a remote DVR site to the Connection List when you do not know the IP address of the site:

1. Click . The Connection List dialog box opens.

Figure 16.  Connection List Dialog Box

2. Click DX8000 Scan. The DX8000 Scan dialog box opens.

Figure 17.  DX8000 Scan Dialog Box

3. Enter an IP address range to search for DVR sites.

a. Enter the first three octets of the IP range you wish to search; for example, 10.10.1.

b. Enter the beginning value for the search range in the fourth octet; for example, 001.

c. Enter the final value for the search range in the text box provided; for example, 254.

NOTE:  To be successful, the following stipulations must be satisfied:

• Each DVR must be attached to the same subnet.

• The first three octets of the IP address of the subnet must be known.

• The range of addresses used in the last octet of the subnet must be known.

NOTE:  Each octet of the IP address must be an integer between 1 and 255.

�

�

�

3a 3b 3c
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4. Click Find.

5. Select one or more DX8000 servers to add to the site tree.

6. Click Add. The site appears in the Connection List.

7. Click OK when you return to the Connection List dialog box.

DELETING A DX8000 DVR SERVER FROM THE CONNECTION LIST

1. Click . The Connection List dialog box opens.

Figure 18.  Deleting a Site from the Connection List

2. Select the DX8000 Series DVR you wish to delete.

3. Click Delete. The site disappears from the Connection List.

4. Click OK.

�

�

�

24 C626M-B (3/05)DX8000 PC Client Application



            
EDITING A DX8000 SERVER’S INFORMATION FROM THE CONNECTION LIST

1. Click . The Connection List dialog box opens.

Figure 19.  Editing a Site from the Connection List

2. Select the DX8000 Series DVR you wish to edit.

3. Click Edit. The Server Information dialog box opens.

Figure 20.  Editing Server Information

4. Enter a new name for the server.

5. Enter a new IP address for the server.

6. If necessary enter a new base port number (9002 is the default).

7. If necessary enter a software upgrade port number (9003 is the default).

8. Click OK. The site appears in the Connection List.

9. Click OK when you return to the Connection List dialog box.

NOTE:  Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, 
but are protected from external threats by a firewall. Client and server ports must be identical.

�

� �

�
�
�
�

�
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CONNECTING TO A REMOTE SITE
You can view live and playback video from multiple DX8000 DVR servers 
simultaneously. 

To connect to an active DX8000 server on the network:

1. Right-click the remote site name from the site tree.

2. Select Connect from the quick-menu.

Figure 21.  Remote Site Connect Quick-Menu

LOGGING IN TO A REMOTE SITE
After a connection to a remote site has been established, log in with a valid user 
name and password for that site. 

To log in to a remote site:

1. Select a remote DX8000 Series DVR site from the site tree.

Figure 22.  Selecting a Site

NOTE:  To access the features of the DX8000 Series DVR, you must log 
in with a valid user name and password. The DX8000 comes equipped 
with a built-in user account named “Guest.” Each time the unit is turned 
on, the Guest account is automatically activated. In addition to the 
Guest account, there are four other user access levels, or groups, that 
can be configured on the DX8000. The Guest user is granted only limited 
access to the system. The other four access levels range from the 
Administrator group, with the most rights and privileges, to the 
Restricted group, with the least rights and privileges. Refer to Definition 
of User Access Levels on page 131 for information on the rights and 
permissions of the user group to which you have been assigned. To 
operate and configure all but the most basic features of the DX8000, you 
must be assigned a user account other than Guest. If you have not been 
assigned a user account, contact your system administrator before 
proceeding.
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2. Go to File > User Log-in.

 

Figure 23.  Log-in Quick-Menu

3. Enter a valid user name in the User Name field and a valid password in the Password field.

4. Click OK.

Figure 24.  Log-in Dialog Box

LOGGING OUT OF A REMOTE SITE
To log out of a remote DVR site:

1. Select the remote server from the site tree.

2. Go to File > User Log-Out.

TIP:  You can also log in to a remote site by right-clicking its site name and then selecting User Log-In from the quick-menu. Refer to 
Figure 23.

TIP:  You can also log out of a remote DVR by right-clicking its site name from the site tree and selecting User Log-Out from the quick-
menu.

NOTES:  

• Logging out of a remote DVR does not disconnect you from that system. Logging out will return you to the Guest account. 
To disconnect from a remote server, refer to Disconnecting from a Remote Site on page 28.

• You can only log out of one server at a time. If you are logged into multiple servers you must log out of each server individually.
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DISCONNECTING FROM A REMOTE SITE
To terminate a connection with a remote DX8000 server:

1. Right-click the name of the remote site from the site tree.

2. Select Disconnect from the quick-menu.

Figure 25.  Remote Site Disconnect Quick-Menu

EXITING THE DX8000 PC CLIENT APPLICATION
To exit the DX8000 PC Client application and return to the Windows operating system, go to File > Exit.

Figure 26.  Exiting the PC Client Application
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Description of Operating Modes
The DX8000 Series DVR has four primary operating modes. These are Live, Playback, Search, and Setup modes. Each operating mode is accessed 
by clicking its corresponding button on the toolbar.

Live Mode – Allows all users to view live video.
Playback Mode – Allows users with Standard User access and higher to play back recorded video.

Search Mode – Allows users with Standard User access and higher to search video data using specific criteria.

Setup Mode – Allows users with Power User access and higher to set up the features and options for the DVR. 
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DX8000 PC Client Application Main Screen
The main screen provides access to both live and recorded video.

Figure 27.  Main Screen Layout

	 Title Bar: Displays the DX8000 application title.

� Menu Bar: Provides access to drop-down menus.

� Toolbar: Provides access to display, setup, export, and search tools.

� Site Tree: Displays top-down, hierarchical management of DX8000 resources, such as servers, cameras, alarms, and relays.

� View Panels: Display live and playback video from attached cameras.

� PTZ Control Panel: Allows users with access rights to operate camera lens control features and to program PTZ presets, patterns, and 
tours. 

� Event Index Panel: Allows users with access rights to search motion and alarm events within a 24-hour period specified in the playback 
timeline. 

� Playback Timeline: Displays a 24-hour timeline marked with color-coded video events. Allows users with Standard User access rights to 
select a date and time for playback.

� Playback Control Panel: Provides buttons for users with access rights to control video playback. Includes forward and reverse playback 
and still image. It also provides controls for playback speed and volume. 


� Playback Zoom Control: Provides users with access rights to operate digital zoom features during playback. 


� Status Bar: Displays current date and time, recorder processing status, disk status indicator, user name of currently logged-in user, and total 
amount of recorded video.

NOTE:  As the storage array of the DX8000 fills beyond its capacity, video is deleted in a first-in, first-out (FIFO) fashion. The disk status 
indicator on the status bar shows the amount of disk space used by recorded video. The red indicator marks the current recording position 
of the disk array, blue indicators mark parts of the array that are storing previously recorded video, and clear indicates that no video has 
been recorded in that area of the array.
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WORKING WITH THE SITE TREE
The site tree provides access to DX8000 resources, such as cameras, alarm inputs, and relay outputs. Objects can be selected by clicking once 
with the left mouse button and linked by dragging and dropping with the mouse.

Figure 28.  Site Tree

NOTE:  Site tree information reflects the current server configuration.

SITE NAME

CAMERA NAME

CHANNEL INFORMATION
-RECORDING TYPE
-RESOLUTION
-FRAME RATE
-IMAGE QUALITY

ALARM INPUTS

RELAY OUTPUTS
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ASSIGNING CAMERAS TO VIEW PANELS

The DX8000 includes 32 view panels that can display cameras from up to five connected DVR sites.

To assign a single camera to a view panel:

1. Click .

2. In the site tree, click the plus sign (+) next to  to expand the tree if necessary.

3. Drag the camera from the site tree onto a view panel. 

4. Repeat the process in step 3 for up to 32 cameras from up to five DVR sites.

Figure 29.  Dragging a Camera to a View Panel

TIP:  To assign all cameras from a single site to the view panels at once, drag  onto a single view panel. (The default arrangement of 
cameras is Camera1, Camera2, Camera3 – from left to right, top to bottom.)

NOTE:  The DX8000 Series DVR supports triplex operation. Triplex operation means the DX8000 will continuously record even while users 
view simultaneous live and playback video or modify the system setup.

�
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LINKING ALARM INPUTS AND RELAY OUTPUTS TO CAMERAS

To link an alarm input to a camera:

1. Click .

2. In the site tree, click the plus sign (+) next to the camera to which you want to link alarms.

Figure 30.  Expanding a Camera Channel Branch 1

3. Click the plus sign (+) next to the  to see the list of alarm inputs.

4. Drag an alarm input onto a camera.

Figure 31.  Dragging an Alarm Input to a Camera
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To link a relay output to a camera:

1. Click .

2. In the site tree, click the plus sign (+) next to the camera to which you want to link relays.

Figure 32.  Expanding a Camera Channel Branch 2

3. Click the plus sign (+) next to  to see the list of relay outputs.

Figure 33.  Expanding a Relay Branch
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4. Drag a relay onto a camera.

Figure 34.  Dragging a Relay to a Camera

TIP:  You can link multiple alarms and relays to a single camera. You can also link a single alarm or relay to multiple cameras. You can also 
link alarms and relays to cameras by dragging them onto individual camera view panels.
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LINKING RELAY OUTPUTS TO ALARM INPUTS

To link a relay output to an alarm: 

1.  Click .

2. In the site tree, click the plus sign (+) next to  to expand the alarm tree if needed.

Figure 35.  Expanding an Alarm Input Branch

3. Click the plus sign (+) next to  to expand the relay tree if needed.

4. Drag a relay output onto an alarm input.

Figure 36.  Dragging a Relay Output to an Alarm Input

TIP:  Relays can also be linked to cameras and alarms on the relay and alarm settings page. Refer to Configuring Basic Relay and Alarm 
Settings on page 102 for more information.
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REMOVING A LINKED ALARM INPUT FROM A CAMERA

To unlink an alarm from a camera:

1. Click .

2. In the site tree, click the plus sign (+) next to the camera from which you want to remove alarms or relays.

3. Drag the alarm or relay above or below the site tree panel and release the mouse button.

4. Repeat the above process for each alarm or relay you want to remove.
 

Figure 37.  Removing an Alarm Input from a Camera
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REMOVING A LINKED RELAY OUTPUT FROM A CAMERA

To unlink a relay from a camera:

1. Click .

2. In the site tree, click the plus sign (+) next to the camera from which you want to remove the relay output.

3. Drag the relay above or below the site tree panel and release the mouse button.

4. Repeat the above process for each relay you want to remove.
 

Figure 38.  Removing a Relay Output from a Camera
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REMOVING A LINKED RELAY OUTPUT FROM AN ALARM INPUT

To unlink a relay from an alarm:

1. Click .

2. In the site tree, click the plus sign (+) next to the alarm input from which you want to remove the relay output.

3. Drag the relay either above or below the site tree panel and release the mouse button.

4. Repeat the above process for each relay you want to remove.
 

Figure 39.  Removing a Relay Output from an Alarm Input
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UNDERSTANDING VIEW PANELS AND WINDOWS
View Panels – A view panel is a division of a view window.  Each view panel contains only a single camera channel. Up to sixteen view panels 
can fit in a single view window.

View Windows – A view window is made up of the entire camera viewing area. View windows are divided into multiple panels. Each window 
can display from one to sixteen individual cameras.

Figure 40.  View Panels and Window

VIEW PANELS

WINDOWS
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CONFIGURING VIEW PANELS

The DX8000 PC Client Application can display up to sixteen cameras simultaneously on a single window.

To configure the view panels in a window:

1. Click .

Figure 41.  Main Display

2. Select a view panel division button from the toolbar.

Displays one camera. Divides screen into 1+5, 2+8, or 1+12 view panels.

Displays four cameras at a time (quad display). Turns window cycling on and off. (Cycles through each 
view window ensuring all cameras get displayed.)

Displays nine cameras at a time. Full-screen view. Expands view window to occupy entire 
monitor screen. Click the right mouse button to exit full-
screen view.Displays 16 cameras at a time.
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NAVIGATING BETWEEN VIEW WINDOWS

The DX8000 PC Client application allows you to monitor up to 32 channels; however, the main screen can display only one to sixteen view panels 
at a time. Since only one screen window can be viewed at a time, you must cycle through multiple windows to view any hidden windows. 
For example, if a single channel is selected to cover the entire window, there will be an additional 31 hidden windows available to cycle through. 
Similarly, if four channels are displayed on a single window, there will be seven hidden windows and so on.

Pressing one of the view panel division buttons sets the number of visible channels on a screen window. Figure 42 illustrates the view panel 
division buttons available on the toolbar.

Figure 42.  View Window Identifier

To manually cycle through hidden view windows, click one of the screen division buttons repeatedly.

For example, click  repeatedly to cycle through each of the eight available view windows.

Continue clicking  until you return to window one.

To cycle automatically through view windows, click .

To turn window cycling off, click  again.

Figure 43.  Hidden View Windows

TIP:  Double-click a view panel to expand it so it fills the entire view window. Double-click again to return to the previous view.
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Live View Mode
All users can view live video from the main screen. Users with Standard User access and higher can operate the on-screen PTZ controls.

Click  to view live video on the main screen.

ASSIGNING CAMERAS TO VIEW PANELS
1. Drag a camera from the site tree onto a camera view panel. Refer to Assigning Cameras to View Panels on page 32 for instructions on how 

to assign cameras to view panels.

2. Repeat the process in step 1 for up to 32 cameras from up to five different DX8000 sites.

Figure 44.  Dragging a Camera to a View Panel

�
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LIVE VIEW ON-SCREEN DISPLAY (OSD)
The DX8000 PC Client Application’s OSD consists of camera and site information that is superimposed on each view panel. Each display item in 
the OSD can be customized for both live and playback viewing.

Figure 45.  Live View OSD

	 PTZ: Indicates that PTZ control is enabled.

� :  Indicates that audio recording is enabled.

� REC: Indicates camera recording mode and status.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates event recording.

� Site Designator: Lists the number and name of the current site.

� Camera Designator: Lists the number and name of the current camera.

� On-Screen PTZ Control: Facilitates mouse control of PTZ functions. Refer to Operating the On-Screen Pan, Tilt, and Zoom (PTZ) Controls 
on page 47. 

� Instant Recording: Starts/stops instant recording if enabled.

NOTE:  A blinking REC indicator signifies event recording.

�

��

� � �
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CUSTOMIZING THE ON-SCREEN DISPLAY (OSD)
Users with Power User access and higher can add and delete on-screen display items.

To customize the on-screen display:

1. Go to View > OSD and then select the items you want to add to or delete from the OSD. Items include

• Site Name

• Camera Name

• Video Recording

• Audio Recording

• PTZ

• Instant Recording

• Select All (shows all items on screen)

Figure 46.  OSD Menu Options

2. Go to View > OSD > Background Color > Set Color to add a contrasting background field behind each OSD display item.

or

Go to View > OSD > Background Color > Disable Background to remove background field.

INSTANT RECORDING

ENABLING AND DISABLING

Users with Power User access and higher can configure the DX8000 for recording video both instantly and in accordance with a preset schedule. 
The Instant Recording mode is enabled from the schedule setup screen. Instant recording is activated from the main screen by clicking the 
Instant Recording icon. For information about adding the Instant Recording icon to the OSD, refer to Adding Instant Recording to OSD on page 46.

To enable the Instant Recording mode:

1. Click .

2. Click . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Enable.
 

Figure 47.  Enabling Instant Recording

To disable the Instant Recording mode, select Disable from the Instant Recording drop-down box.
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ADDING INSTANT RECORDING TO OSD

To add the Instant Recording icon to the OSD, click View > OSD > Instant Recording. 

Figure 48.  Adding the Instant Recording to OSD

ACTIVATING AND DEACTIVATING INSTANT RECORDING

The Instant Recording mode must first be enabled from the Schedule setup screen. For more information, refer to Instant Recording on page 45.

To activate instant recording:

1. Ensure that instant recording is enabled, and then double-click the Instant Recording icon. The Instant Recording icon changes from silver 
to blue, indicating that instant recording is activated.

2. If video recording is enabled, verify that REC blinks, If video recording is not enabled, REC is not displayed. 

Figure 49.  Activating Instant Recording

To deactivate instant recording, double-click the Instant Recording icon.

	

�

46 C626M-B (3/05)DX8000 PC Client Application



OPERATING THE ON-SCREEN PAN, TILT, AND ZOOM (PTZ) CONTROLS
Users with Standard User access and higher may operate pan, tilt, and lens functions of cameras that support such features. PTZ functions can 
be controlled on-screen in Live mode using the mouse. 

To operate the on-screen PTZ controls:

1. Click .

2. Select a PTZ-enabled camera from the site tree.

3. Place the mouse pointer in the middle of the camera’s view panel. The mouse pointer will change to a black cross when on-screen PTZ 
control is available.

Figure 50.  On-Screen PTZ

4. Click the left mouse button, and then drag the mouse pointer in the direction you want to move the camera. The display changes to an 
arrow indicating the direction of the mouse.

Figure 51.  On-Screen PTZ Movement

5. Release the mouse button when you have repositioned the camera to the desired location.

NOTE:  PTZ control is available only for cameras that support PTZ functions using Pelco’s P, D, or Coaxitron® protocols. Refer to RS-422/
RS-485 Communication Port Software Configuration section in the Operation and Programming manual for information on configuring PTZ 
ports. In addition, the PTZ option must be enabled and a protocol must be assigned to the camera channel. Refer to Configuring Cameras on 
page 97 for instructions.

�
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6. To adjust camera lens features, click the plus (+) or minus (−) button next to each function on the keypad. Refer to Figure 52.

Figure 52.  PTZ Keypad with Camera Lens Controls

7. To adjust camera zoom using the mouse, rotate the mouse wheel forward to zoom in and backward to zoom out.

Figure 53.  Mouse Wheel Zoom

TIP:  You can also use keyboard shortcuts to operate the lens features of cameras such as Pelco’s Spectra III™.  For more information about 
using keyboard shortcuts, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions on page 49.

�
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USING PC KEYBOARD SHORTCUTS TO OPERATE PTZ AND LENS FUNCTIONS
Users with Standard User access and higher may use a PC keyboard to operate PTZ and lens functions of cameras that support such features. 
PTZ and lens functions can be controlled in Live mode using the keyboard. 

Table A describes the keyboard buttons that you use to control PTZ and lens functions. Operation of the keyboard shortcuts, with the exception of 
the plus (+) and minus (−) keys, are self-explanatory. A procedure is provided following Table A that describes how to use the plus (+) and minus 
(−) keys.

To use the keyboard (+) and (−) keys to control camera pan and tilt speed:

1. Click .

2. Select a PTZ-enabled camera from the site tree.

3. Click the mouse pointer in the camera’s view panel.

4. Press and hold the up/down and left/right arrows to pan and tilt the camera.

5. Press the plus (+) key once to increase the pan and tilt speed. Press the minus (−) key once to decrease the pan and tilt speed. 

Table A.  Standard PC Keyboard Functions for Controlling PTZ and Lens Functions

Key(s) Description
Insert and Delete These keys provide the following functionality:

• On-screen display, preset and pattern modes: Insert increases and Delete decreases focus, 
performing the same actions as the focus control on the PTZ keypad. 

• Remote camera programming mode: Insert and Delete perform the same actions as the PTZ 
keypad focus (+) and (−) buttons, navigating up and down the camera menu choices.

Home and End These keys provide the following functionality:
• On-screen display, preset and pattern modes: The Home key opens and the End key closes 

the iris, performing the same actions as the PTZ keypad iris (+) and (−) buttons. 

• Remote camera programming mode: The Home key selects an option from the camera’s on-
screen menu. The End key cancels an option or exit a menu. These keys perform the same 
actions as the PTZ keypad iris (+) and (−) buttons.

Page Up and Page Down These keys perform the same functionality in the on-screen display and the preset and pattern 
modes as the PTZ keypad zoom (+) and (−) buttons. Page Up zooms in; Page Down zooms out.

Up and Down Arrow These keys provide the following functionality:
• On-screen display, preset and pattern modes: The up arrow key raises the camera and the 

down arrow key lowers the camera. The keys perform the same actions as clicking the left 
mouse button when in on-screen PTZ control and dragging the mouse pointer up and down. 

• Remote camera programming mode: The arrow keys navigate up and down the camera menu 
choices. The keys perform the same actions as the PTZ keypad focus (+) and (−) buttons.

Left and Right Arrow These keys provide the same actions as clicking the left mouse button for on-screen PTZ control 
and dragging the mouse pointer left and right. The left arrow key pans the camera in a counter-
clockwise direction, and the right arrow key pans the camera in a clockwise direction. 

+ and – These keys perform similar actions in the on-screen display and the preset and pattern modes as 
clicking the left mouse button when in on-screen PTZ control and dragging the mouse pointer to 
change the speed of camera movement. The plus (+) key, pressed once increases the camera’s pan 
and tilt speed. The minus (−) key pressed once decreases the camera’s pan and tilt speed. Each 
time the plus (+) key is pressed the pan and tilt speed is increased toward the maximum speed. 
Each time the minus (−) key is pressed, the pan and tilt speed is decreased toward the minimum 
speed. 
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PTZ PRESETS
A preset is a user-defined camera position using pan and tilt, zoom, and focus commands.  A DX8000 Series DVR can address up to 32 PTZ 
presets (1-32).  Preset 95 is reserved for remote camera setup, and preset 99 is reserved for camera autoscan mode.

PROGRAMMING A PRESET

To program a PTZ preset:

1. Click .

2. Drag a camera from the site tree onto a view panel.

3. Click .

Figure 54.  Main Display with PTZ Control Pad Visible

NOTE:  Only cameras that support positioning and programming using D, P, or Coaxitron protocols can use this feature.

IMPORTANT:  To program or clear presets, preset tours, and patterns, the  icon must be engaged.  To activate presets, tours, and 

patterns, the  icon must be disengaged.

TIP:  Clicking the  icon places DX8000 in PTZ programming mode. While in PTZ programming mode, multiple presets 

can be programmed until the  icon is pressed again.
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4. Using the on-screen PTZ controls and PTZ keypad, move the camera to the desired position and adjust zoom and iris settings.

Figure 55.  Moving to a Preset

5. Using the PTZ keypad, select a number for the new preset (for example, 1).

Figure 56.  Programming a Preset

6. Click  to store the preset in the selected memory location.

7. Repeat steps 4-6 for each preset you want to program.

8. Click  again to exit programming mode.

EXIT

�

�

�
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ACTIVATING A PRESET

To activate a preset:

1. Click a preset number (1-32) on the keypad.

2. Click  to activate preset. The camera repositions to the new preset.

Figure 57.  Activating a Preset

CLEARING A PRESET

To clear a preset:

1. Click  to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click  to exit programming mode.

Figure 58.  Clearing a Preset

TIP:  Double-digit presets can be set or activated by pressing the first digit and then the second digit sequentially. For example, preset 20 
can be selected by clicking the number 2 and then the number 0 on the PTZ keypad.

	

�

�

�
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PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a definite beginning and end. Patterns are made up of a sequence of standard pan, tilt, 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra dome, that is connected to the DX8000. 
Depending on the type and configuration of the PTZ device, the DX8000 can address up to four unique PTZ patterns. Once defined, a pattern can 
be activated with a series of on-screen commands. A pattern will run continuously until it is deactivated. 

PROGRAMMING A PATTERN

To program a pattern:

1. Click .

2. Drag a camera from the site tree onto a view panel.

3. Click  to enter programming mode.

4. Using the PTZ keypad, select a number for the pattern (1 to 4).

5. Click .

6. Move the camera through a series of movements using the on-screen pan and tilt, zoom, and focus controls.

Figure 59.  Programming a Pattern

To stop programming a pattern:

1. Click .

2. Click .

NOTE:  Only PTZ-enabled cameras that support pattern programming through D, P, or Coaxitron protocols can use this feature.

NOTE:  Certain PTZ devices, like Pelco’s Spectra series domes, will display an on-screen message stating the amount of remaining memory 
available for pattern programming.

�

�

�
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ACTIVATING A PATTERN

To activate a pattern:

1. Click a pattern number (1 to 4) on the keypad.

2. Click .

Figure 60.  Activating a Pattern

CLEARING A PATTERN

To clear a pattern:

1. Click  to enter programming mode.

2. Select a pattern number (1 to 4) on the keypad.

3. Click .

4. Click .

5. Click  again.

6. Click  again to exit programming mode.

Figure 61.  Clearing a Pattern

IMPORTANT:  A pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

	

�

�
	

�

�
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ACCESSING PROGRAMMING FEATURES OF REMOTE CAMERAS

You can use the PTZ function to program features of remote cameras, such as Pelco’s Spectra or Esprit®.

To access a programming menu for a remote camera:

1. Click .

2. Drag a camera from the site tree onto a view panel.

Figure 62.  View Panel

NOTE:  Only cameras that support remote programming through D, P, or Coaxitron protocols can use this feature.
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3. Click  from the keypad to access remote camera setup mode.

Figure 63.  PTZ Control Panel

4. Use the on-screen PTZ controls or the focus (+) and focus (−) buttons to navigate up and down camera menu choices.

5. Click the iris (+) button to select an option from the camera’s on-screen menu.

6. Click the iris (−) button to cancel an option or exit a menu.

Figure 64.  Camera Setup Menu

TIP:  For certain camera models, you can also select preset number 95 from the keypad to access remote setup mode. 

To access preset number 95, click , 9, 5, and  from the PTZ keypad.

TIP:  You can also use the on-screen PTZ controls with your mouse to navigate camera menus. Click and drag the mouse up or down to 
move between menu options and then select the option using the iris (+) button.

�
�

�

56 C626M-B (3/05)DX8000 PC Client Application



SENDING AUXILIARY COMMANDS TO A DEVICE
The DX8000 auxiliary feature allows you to control external equipment connected to the auxiliary outputs of Spectra domes or Esprit positioning 
systems. The auxiliary function is implemented through the D Protocol and P Protocol. In this case, the attached camera and DX8000 must be 
configured to communicate using one of these protocols. 

The Aux key selects the auxiliary mode. Buttons 1- 4 select which of the camera’s auxiliary outputs to operate. Buttons 1–4 operate as a toggle 
(on/off) each time they are clicked. 

For example, an Esprit equipped with a wiper uses Aux 1 to control the wiper. In this case, pressing Aux+1 sends a command to the Esprit to 
operate the wiper. You must configure the camera to establish how the camera responds to an auxiliary command. For detailed information about 
how a specific Spectra or Exprit camera system interprets auxiliary commands, refer to the documentation that accompanies your Spectra or 
Esprit camera system. 

To send an auxiliary command:

1. Click  to enter the programming mode. 

2. Select the camera in the DX8000 view panel to which you want to send the auxiliary command.

3. Click the Aux button.
 

Figure 65.  Auxiliary (Aux) Button

Keypad buttons 1–4 are available.

Figure 66.  Keypad Buttons 1–4

4. Click a keypad button (1–4). The auxiliary function assigned by camera for the selected button is executed.

�

�
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CONFIGURING PRESET TOURS
A preset tour allows a camera to move through a programmed sequence of PTZ presets. The DX8000 Series DVR can store up to four preset 
tours. While four tours can be programmed, only one tour can be activated at a time. A preset tour will operate continuously until another PTZ 
control action is performed.

PROGRAMMING PRESET TOURS

To access the Preset tour group programming screen:

1. Click .

2. Click  and then  on the PTZ keypad to bring up the preset tour dialog box.

Figure 67.  Preset Tour Dialog Box

3. Select the preset tour (1-4) that you want to program from the drop-down box.

4. Follow the directions in the following sections to add presets to and delete presets from a tour.

NOTE:  At least one PTZ preset must be set in order to create a preset tour.

�
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Adding Presets to a Tour

To add presets to a tour:

1. Click the check box next to one of the presets you want to add to the tour.

2. Double-click within the Dwell Time field of the preset and increase or decrease the time in seconds the camera will remain on the preset 
during that sequence of the tour. 

3. Repeat steps 1 and 2 for each additional preset you want to add to the tour.

4. Click Add to Group.

5. Click Save.

6. Click Exit to return to the main screen.

Figure 68.  Adding Preset to Tour

	 �

�

� �
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Deleting Presets from a Tour

To delete presets from a tour:

1. Click the check box next to one or more presets you want to delete from the tour.

2. Click Delete.

3. Click Save.

4. Click Exit to return to the main screen.

Figure 69.  Deleting Preset from Tour

� �

	

�

60 C626M-B (3/05)DX8000 PC Client Application



ACTIVATING A PRESET TOUR

To activate a preset tour: 

1. Click  and then  to bring up the preset tour dialog box.

2. From the drop-down box, select the preset tour (1-4) you want to activate.

3. Click Save. 

4. Click Apply. 

5. Click Exit to return to the main screen.

6. Click  on the PTZ keypad to exit programming mode.

7. Click  on the PTZ keypad to activate the tour.

Figure 70.  Activating a Preset Tour

DEACTIVATING A PRESET TOUR

To deactivate a preset tour, use the mouse to move the on-screen PTZ control or activate a PTZ preset.

NOTE:  You can save a preset tour for later use without engaging the tour by continuing on to step 5 without clicking Apply.

TIP:  To reactivate the last preset tour you configured, click .

�

�

� �
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Playback Mode
Recorded video can be played back one channel at a time on the DX8000 PC Client application. Like live video, recorded video is viewed from the 
camera view panels on the main screen. Refer to Understanding View Panels and Windows on page 40 for information on view panels. Only 
users with Standard User access and higher are allowed to view recorded video. 

ACCESSING PLAYBACK MODE
Click  to access Playback mode.

ASSIGNING CAMERAS TO VIEW PANELS
1. To assign a camera to a view panel, drag it from the site tree onto a camera view panel. 

Figure 71.  Dragging a Camera to a View Panel

2. Repeat this process for up to 32 cameras.
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PLAYBACK ON-SCREEN DISPLAY (OSD)
The on-screen display for playback is identical to live view with the exception of a date/time field in place of the PTZ designator.

Figure 72.  Playback OSD

PLAYBACK CONTROLS
Use the playback controls to start playback, control direction, and adjust speed. Click  at any time to return to live view. 

Figure 73.  Playback Controls

Figure 74.  Playback Speed and Volume Controls
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PLAYBACK TIMELINE
The playback timeline is used to select a day and time to begin playback. The timeline includes a horizontal slider that can be moved to select 
playback time over a 24-hour period. Time periods containing recorded video are represented as color-coded segments of the timeline. Figure 75 
illustrates the timeline color-coding scheme.
 

Figure 75.  Playback Timeline
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� Total number of view windows
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� Normal recording
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PLAYING BACK VIDEO BY TIME
To start video playback from a particular point in time:

1. Click .

2. Select a camera by clicking it in the site tree. 

3. From the drop-down box, select the day that you want playback to begin.

Figure 76.  Date Selection Drop-Down Box

4. Use the spinner buttons to select the time.

Figure 77.  Time Selection Spinner Buttons

Figure 78.  Timeline Slider Control

5. Click  to begin viewing. 

TIP:  You can also select the camera from a view panel if it appears in the window.

NOTE:  Time is displayed in 24-hour clock format.

TIP:  You can select the time by moving the slider along the timeline.

TIMELINE SLIDER

INSTANT REPLAY

The DX8000’s ability to perform instant playback of video is limited by a two-minute delay in disk recording. The DX8000 has a built-in 
latency of approximately one minute between the time that video is captured and when it is written to disk. This delay exists to ensure that 
video is accurately stored and that the DVR’s database is updated correctly.
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PLAYING BACK VIDEO BY EVENT
Standard users and higher can search video by events, such as motion detection or alarm activation. 

To play back video recorded during an alarm or motion event:

1. Click .

2. Go to View > Index View to show the event index panel.

Figure 79.  Index View Menu Option

3. Select a camera by clicking it in the site tree.

4. From the drop-down box, select the day that you want playback to begin.

Figure 80.  Selecting a Date
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5. From the event type drop-down box, select the event type you want to view. Options are

• All

• None

• Motion

• Alarm in

Figure 81.  Event Type Drop-Down Box

6. Select an event from the index.

Figure 82.  Event Index Panel

7. Click  to begin viewing. 

NOTE:  A sensor event is identical to an alarm event.
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OPERATING PLAYBACK DIGITAL ZOOM
Video playback can be zoomed using a control keypad or the mouse when in Playback or Search modes. In Playback mode, the on-screen PTZ 
feature is replaced with the mouse-activated digital zoom. Playback digital zoom is also available in Search mode.

ZOOM USING THE DIGITAL ZOOM CONTROL

To zoom using the digital zoom control: 

1. Click  to start video playback.

2. Use the digital zoom control to zoom and pan video playback.

Figure 83.  Playback Digital Zoom Control

PAN IMAGE
WITHIN FRAME

ZOOM INZOOM OUT
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ZOOM USING THE MOUSE

To zoom using the mouse:

1. Click  to start video playback.

2. Click and drag the mouse diagonally in a downward direction to zoom in.

Figure 84.  Zoom In Using Mouse

3. Click and drag the mouse diagonally in an upward direction to zoom out.

Figure 85.  Zoom Out Using Mouse
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PANNING A ZOOMED IMAGE

To pan a zoomed portion of video within the view panel: 

1. Right-click within the view panel.

2. Click and drag the mouse using the left mouse button in the direction you want to move the video image. (Notice that the mouse pointer 
now resembles a hand.)

3. Right-click again to return to zoom mode.

Figure 86.  Panning Zoomed Video with the Mouse

VIEWING VIDEO IN THE DEINTERLACED MODE
Images recorded at 4CIF at a low frame rate per second might move or tear. In this case, you can use the View menu’s Deinterlaced Image option 
to enhance the displayed image. In the deinterlaced mode, the DX8000 converts the recorded image and displays it at 2CIF resolution. The 
process removes one of the 4CIF interlaced fields (even or odd) from the 4CIF recorded image to arrive at 2CIF resolution for the displayed image. 
The original image is retained at the recorded 4CIF resolution. 

For exported images, the DX8000 provides a global option for enabling a deinterlacing filter. In this case, the selected channel’s image is 
exported at 2CIF resolution. This setting is effective for all channels and cannot be set for individual channels. For more information about 
enabling the deinterfacing filter, refer to Enabling the Deinterlacing Filter on page 85.

To view video using the deinteraced option:

1. Click  to start video playback.

2. On the menu bar, click View > Display deinterlaced image.
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Viewing Live and Playback Video Simultaneously
The DX8000 PC Client Application allows simultaneous viewing of live and playback video from a single camera source.

To view live and playback video from the same camera:

1. Click .

2. Drag a camera from the site tree to a view panel.

3. Click  to begin playback.

4. Drag the same camera from the site tree onto a different view panel while video is playing.

Figure 87.  Viewing Live and Playback Video Simultaneously from a Single Channel

�

�      

�
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Search Mode
The DX8000 PC Client Application supports three video search methods: index, thumbnail, and pixel.

Click  to enter the search screen.

SEARCH SCREEN
The search screen facilitates access to the search capabilities of the DX8000. Available search methods include index, thumbnail, and pixel. Each 
search method allows users with Standard User access and higher to locate video data instantly using criteria such as time of day or changes in 
screen pixels.

Figure 88.  Search Mode Screen

	 Index Search: Allows users to search motion and alarm events listed in the event index panel. 

� Thumbnail Search: Allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a series of 
thumbnail images. Each thumbnail represents the first image recorded during a specified period of time. Thumbnails can be expanded and 
collapsed to represent hourly, 10-minute, and 1-minute intervals.

� Pixel Search: Allows users to search any 24-hour period of recorded video automatically for changes in screen pixels. 

� Site Tree: Facilitates top-down, hierarchical management of DX8000 resources, such as servers, cameras, alarms, and relays.

� View Window: Displays search video, image thumbnails, and pixel grid.

� Event Index Panel: Lists motion and alarm events over the 24-hour time period specified in the playback timeline. 

� Playback Timeline: Displays a 24-hour timeline marked with color-coded video events. Allows user to select a date and time for playback. 

� Select All Check Box: Enables playback for all visible view panels when selected. If this check box is deselected, only the selected 
channel will play. This control is only available while using Index Search.

�

�
�

�

�

�

�

�
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� Playback Control Panel – Provides buttons to control video playback. Includes forward and reverse playback and still image. Also provides 
controls for playback speed and volume.

� Playback Zoom Control Keypad – Provides access to digital zoom features during playback.

INDEX VIDEO SEARCH
Index search allows a user to search video by events, such as motion detection or alarm activation. Events are listed chronologically and by type.

To search video by motion or alarm events:

1. Click .

2. Click .

3. Select a view panel division from the toolbar.

4. From the site tree, drag the camera channel you want to search onto one of the view panels.  

5. Click the view panel of the channel you want to search. 

6. From the drop-down box on the playback timeline, select the day you want playback to begin.
 

Figure 89.  Index Search Screen

NOTE:  As in Playback mode, digital zoom, export, and print features are available in Search mode. Refer to Operating Playback Digital 
Zoom on page 68, Exporting Video on page 82, and Printing Images on page 94 for instructions on using these features.

TIP:  To ensure that the proper camera channel is selected, check the camera information box above the playback timeline or verify that the 
desired view panel is framed with a thin red outline.

�

�

�

�

�
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7. Select the event type you want to view from the event type drop-down box. Options are

• All

• None

• Motion

• Alarm in
 

Figure 90.  Event Type Drop-down Box

8. Select an event from the index.
\

Figure 91.  Event Index Panel

9. Verify that the “Select all” check box is selected. Deselecting the “Select all” check box will disable playback for all view panels except the 
channel being searched.

10. Click  to begin viewing. 

NOTE:  Only events recorded for the selected camera are listed in the index. A sensor event is identical to an alarm event.

TIP:  The DX8000 PC Client Application allows you to view playback on multiple cameras in addition to the camera being searched. This 
feature is valuable if you want to examine a variety of views recorded at the time a certain event was detected.
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THUMBNAIL VIDEO SEARCH
Thumbnail search allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a series of thumbnail 
images. Each thumbnail represents the first image recorded during a specified period of time. Thumbnails can be expanded and collapsed to 
represent hourly, 10-minute, and 1-minute intervals.

To search video visually using thumbnail images:

1. Click .

2. Click .

3. Select a camera from the site tree.

Figure 92.  Thumbnail Search Screen

4. From the drop-down box, select the date on which you want to begin your search.

Figure 93.  Date Selection Drop-down Box

�

�
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5. Click the thumbnail for the hour you want to begin searching.

Figure 94.  One-Hour Interval Thumbnail Images

6. Click  to change the thumbnail time range to shorter intervals, or click  to change the thumbnail time range to longer intervals.

• Click  to change from 1-hour intervals to 10-minute intervals.

• Click  again to change from 10-minute intervals to 1-minute intervals.

• Click  once to change from 1-minute intervals to 10-minute intervals.

• Click  again to change from 10-minute intervals to 1-hour intervals.

Figure 95.  Thumbnail Images Expanded to 10-Minute Intervals

CONTRACTEXPAND
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Figure 96.  Thumbnail Images Expanded to One-Minute Intervals

7. Click the thumbnail of the interval you want to search.

8. Click  to view video.

9. Click  to return to thumbnail images.

TIP:  Double-clicking a thumbnail image will enlarge the image and begin playback.
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PIXEL VIDEO SEARCH
The DX8000 PC Client application allows a user to search any 24-hour period of recorded video automatically for changes in screen pixels. This 
feature can be configured to identify motion events even when motion detection has not been enabled on a camera.

To search video by analyzing changes in screen pixels:

1. Click .

2. Click .

3. Select a camera from the site tree.

4. From the drop-down box, select the date on which you want to begin your search.

5. Select the start and end times to define your search range.

6. Using your mouse, highlight areas on the grid that you want to search for pixel changes.

• Hold down the left mouse button and drag to select areas.

• Hold down the right mouse button and drag to clear areas.

7. Adjust the pixel sensitivity threshold. (Moving the slider to the left decreases sensitivity and moving it to the right increases sensitivity.)

8. Click Start and then wait for the progress line on the status bar to return to Ready.

 

Figure 97.  Pixel Search Screen

TIP:  Use the  icon to show and hide the pixel grid for a clearer view in the search screen.

�
�

�
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After the search has been completed, a series of thumbnails appear on the screen below the search grid. Each thumbnail contains the first image 
of recorded video for the listed time period.

1. Click a thumbnail.

Figure 98.  Thumbnail Images Marking Pixel Changes

2. Click  to begin viewing video.

3. Click  to remove the thumbnail results.

TIPS:  

• Double-clicking a thumbnail will cause it to begin playing.

• Click  and  to move backwards and forwards through thumbnails.

�
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Viewing and Searching Backed Up Video
The DX8000 PC Client application provides Standard Users and higher the ability to view previously backed up video data. 

To view back up video data:

1. Ensure that you have the correct backup device connected directly to your client PC. Example devices include

• CD-ROM/R/RW drives

• DVD-ROM/R/RW drives

• External drives

• Shared network storage

2. Insert the backup media into the device.

3. Click .

4. Go to File > Backup Search. The backup search screen appears.

Figure 99.  Backup Search Screen

5. Click “Update list” to search backup storage devices for DX8000 backup files.

6. Select a file from the list to view.

7. Click OK. The backup search screen disappears and the site tree now displays only the server and cameras that are recorded in the selected 
backup file.

NOTE:  Archived PDB data refers to files stored in the DX8000’s native backup format. The acronym PDB is used to represent data stored in 
Pelco’s Proprietary Data Base format.

�

�

�
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Figure 100.  Viewing Backed-Up Data

8. Search and play back the backed-up video just as you would normal video. Refer to Index Video Search on page 73, Thumbnail Video Search 
on page 75, and Pixel Video Search on page 78. 

To exit Backup Search and return to the normal DVR search mode, go to File > End Backup Search.
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Exporting Video
Power Users and Administrators can export sections of prerecorded video to a local hard disk drive or other device attached to a client PC. The 
following instructions demonstrate how to export video.

EXPORTING BOOKMARKED VIDEO REGIONS
You can bookmark multiple regions of video along the timeline for export. Bookmarked regions are designated with start point and end point 
bookmarks. Multiple regions can be bookmarked along a single 24-hour timeline, but only a single channel can be exported at a time. Book-
marked regions are listed in the Export Video dialog box at the time of export. 

CREATING BOOKMARKS

To select a region to export:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode or proceed to step 3 if you are in Search mode.

3. Select a camera from the site tree.

4. Locate the timeline slider at the beginning of the range you want to bookmark.

5. Click . A red bookmark flag appears on the timeline. 

Figure 101.  Setting a Starting Bookmark

6. Locate the timeline slider at the end of the range you want to bookmark.

7. Click . The bookmark flag and the region between bookmarks turn gray.

Figure 102.  Setting an Ending Bookmark

NOTE:  You must put the recorder in Playback or Search mode in order to export video. You cannot access Export in Live mode.

IMPORTANT:  To export video or still images to a CD-R/RW or DVD-R/RW, you must have Nero Express CD burning software version 
6.3.0.3 installed on your client PC. If you do not have this version of Nero Express, you can download an update or demo version at 
http://www.nero.com.

TIP:  You can use the drop-down box and spinner buttons above the timeline to locate a bookmark.

� �

� �
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Repeat steps 4 through 7 for each additional region you want to bookmark for that camera.

8. Click  if you are in Live mode or proceed to step 8 if you are in Search mode.

9. Click  and follow the directions in the following section, Performing the Export.

CLEARING BOOKMARKS

To clear a single bookmark:

1. Select a bookmark flag from the timeline. The bookmark flag should change color to red.

2. Click  to remove the selected bookmark.

Figure 103.  Removing a Single Bookmark

To clear all bookmarks, click .

Figure 104.  Removing All Bookmarks

IMPORTANT:  Exporting a bookmarked region of video requires at least one pair of start and end bookmarks. If only one bookmark is set, 
video will not be marked for export.

	 �
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INSERTING AND REMOVING A USB FLASH DRIVE
The DX8000 supports both USB 1.1 and USB 2.0 flash drives. To ensure data is not lost or corrupted when exporting data to a USB flash drive, 
follow the steps listed in Removing a USB Flash Drive . 

INSTALLING A USB FLASH DRIVE

To install a USB flash drive into the DX8000:

1. Insert the USB drive into the PC’s USB 2.0 port. 

2. Wait five seconds while the PC recognizes and automatically installs the device.

REMOVING A USB FLASH DRIVE

You can remove a USB device within the DX8000 environment. In this case, you do not have to exit to the Windows environment.

To remove the USB flash drive from the PC, follow the Windows instructions applicable for your machine. For example, for Windows XP:

1. Click the Safely Remove Hardware icon in the task bar. 

Figure 105.  Safely Remove Hardware Message

The system display a message to safely remove the USB device. 

Figure 106.  Safely Remove USB Mass Storage Device Response

2. Click the Safely remove USB Mass Storage Device - Drive(G:) box. The system displays a confirmation message. 

Figure 107.  Safe to Remove Hardware Message

3. Remove the USB flash drive. 

NOTE: The DX8000 does not support exporting or backing up to CD-RW and DVD-RW disks, but does support exporting or backing up to 
CD-R and DVD-R disks.

CAUTION:  Improperly removing a USB drive can cause data to be lost or corrupted.
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ENABLING THE DEINTERLACING FILTER
Images recorded at 4CIF at a low frame rate per second might move or tear. The DX8000 provides a global option for enabling deinterlacing       
filtering to enhance the exported image for 4CIF recorded channels. In this case, the exported image is converted to 2CIF resolution. This setting 
is effective for all channels, and cannot be set for enabling individual channels. For more information about the viewing video in the deinterlaced 
mode, refer to Viewing Video in the Deinterlaced Mode on page 70.

To enable the deinterlacing filter:

1. Make sure the DVR is in Playback or Search mode by clicking  or .  

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. From the Export Format area, select the “Enable deinterlacing filter” check box. 

Figure 108.  Enabling the Deinterfacing Filter from the Export Video Dialog Box

MAPPING AND DISCONNECTING A NETWORK DRIVE
You can export sections of prerecorded video to a network drive. The DX8000 allows you to map to or disconnect from a network drive. You need 
to know what letters are already assigned to drives and the path to the folder you want to map to.

 To map a network drive: 

1. Make sure the DVR is in Playback or Search mode by clicking  or .  

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

Figure 109.  Export Video Dialog Box
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4.  Click Map NetDrv. 

Figure 110.  Clicking the Network Drive Button

The Map Network Drive dialog box opens asking for a drive letter and path. 

Figure 111.  Map Network Drive Dialog Box

5. In the Drive drop-down box select a drive letter that is not being used.

6. Type the path in the Folder drop-down box; \\servername\foldername is an example.

7. (Optional) Click the “Reconnect at logon” box if you do not want the mapped drive to remain connected each time you logon. 
86 C626M-B (3/05)DX8000 PC Client Application



8. Click Finish. The newly mapped drive is added as a remote drive and is displayed in the Device area. The mapped drive can now be 
accessed just like a local drive.

Figure 112.  Mapped Drive Added as a Remote Drive

To disconnect the network drive:

1. Click Disconnect NetDrv. The Disconnect Network Drive dialog box opens. 

Figure 113.  Disconnect Network Drive Dialog Box

2. Select the network drive you want to disconnect, and then click OK. The drive is disconnected and removed from the Export Video dialog 
box’s Device area.
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PERFORMING THE EXPORT
To export video:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. Click the plus (+) sign next to a drive in the Device list. Available devices are indicated by a check box to the left of the device name.

Figure 114.  Exporting Selected Video

5. Select the check box of the desired device. If you choose a remote drive, select the drive and folder path where you would like to store the 
exported file. You can also click the Browse button to access the file system for the appropriate folder.

Refer to Table B for a listing of available devices. 

Table B.  Available Backup Devices

TIP:  If your DX8000 is connected to a network that supports shared folders and drives, you can map a network drive by right-clicking the 
Network Drive icon in the device list. To map a network drive, select Add Network Drive from the quick-menu and follow the on-screen 
directions.  To remove a mapped drive, right-click the Network Drive icon and select Remove Network Drive.

Device Type Available Devices

Optical Drives CD-R/RW
DVD-R/RW

Hard disk drive Local Drives
Remote Drives

Removable drive USB Flash Drive

10.0.1.14
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6. Select the check box of the video time range you want to export. You can export multiple time ranges simultaneously. For more information, 
refer to Changing a Bookmarked Time Range on page 89.

7. Click in the File Name box and type the file name for each selected video time range. You can accept the default file name assigned to the 
time range. For more information, refer to Assigning a Custom Export Video File Name on page 90.

8. Select the export format. For more information, refer to Selecting the Export Format on page 91.

9. Click Export. 

CHANGING A BOOKMARKED TIME RANGE

To change a bookmarked time range or create a new time range to be exported:

1. Select the desired row in the Time Range table.

2. Double-click the Start Day field, and then use the spinner buttons to set the start date for the export.

3. Double-click the Start Time field, and then use the spinner buttons to set the start time for the export.

4. Double-click the End Day field, and then use the spinner buttons to set the end date for the export.

5. Double-click the End Time field, and then use the spinner buttons to set the end time for the export.

6. Select the check box next to each time range you would like to export.

Figure 115.  Export Time Range

NOTE:  Start dates and times cannot be set later than end dates and times.

�� � � �
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ASSIGNING A CUSTOM EXPORT VIDEO FILE NAME

By default, the DX8000 assigns a file name to each time range. When the video channel selected is exported, the file is assigned the name 
appearing in the Name column.  

Figure 116.  Default File Names

The default filename is constructed from the information displayed in the Start Day, Start Time, End Day, and End Time columns. 

To assign a custom file name for a time range:

1. Verify that the check box of the row you want to rename is selected.

2. Enter a file name for the file you want to export. (Export file names follow standard Windows file-naming conventions.)

3. Click Apply. The Apply button updates the Name field.

Figure 117.  Renaming Export Time Ranges

�

	 �
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SELECTING THE EXPORT FORMAT

To select the export format, select the radio button of the file format you want to export. The available formats are listed in Table C.

Table C.  Export Data Types

AVI Saves video sequence as a standard Windows video format.

ASF Saves video sequence as a standard Windows media file.

Native
Saves video sequence using DX8000’s proprietary compression 
format. Native format provides increased compression and 
smaller file sizes.

BMP Saves a still image file in standard Windows bitmap format. Only 
the first frame of the video sequence is saved.

JPEG Saves a single compressed image file. Only the first frame of the 
video sequence is saved.

TIF

Saves a single uncompressed image file in Tagged Image File 
Format. Only the first frame of the video sequence is saved. 
Saved images contain a digital watermark to secure against 
unauthorized alteration.

NOTES:  

• When exporting video in the native format, the DX8000 embeds a digital watermark in the video stream for the purpose of        
authentication. Watermarking ensures that an image has not been edited or damaged after it has been recorded. The watermark is an 
encrypted, digital signature embedded in the video stream during the compression stage, protecting the video from the moment of 
creation. The DX8000 Viewer software is capable of reading a DX8000 watermark and verifying the originality of the video. 

• Video exported in AVI or ASF format can be viewed using standard viewer software such as Windows Media Player. When exporting 
video in the native format to a CD or DVD device, the DX8000 will automatically include the DX8000 Viewer application along with 
the video. This viewer is designed to play a variety of still image, video, and audio media formats, including the native DX8000 format. 
The DX8000 Viewer application will automatically run each time a CD or DVD created by the DX8000’s export feature is inserted into 
a Windows-based PC. To ensure that the viewer software runs automatically after the disk has been inserted, verify that the autorun 
feature of your PC’s optical drive has not been disabled.
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EXPORTING A SEQUENCE OF STILL IMAGES

To export a sequence of still images:

1. Select a still image format. Options are BMP, JPEG, and TIF.

2. Select the number of images (1 to 999) you want to save in the sequence.

3. Select the time interval between each saved image in the sequence. Options are

• Continuous

• 0.5 seconds

• 1 second

• 2 second

• 3 second

• 4 seconds

• 5 seconds

Figure 118.  Still Image Export Formats

FINALIZING AN EXPORT PROCESS

To finalize the export process:

1. Make sure that the export media selected is inserted in the drive unit and that the drive is ready. 

2. Select the check mark of each time range you want to export.

3. Select the Audio Record check box if you want to include recorded audio.

4. Select the Real Time check box to export video using standard clock time.

NOTE:  Still image formats export the first frame of a bookmarked region and then a single frame for each time interval until the number of 
images specified has been exported. For example, consider exporting a six-hour bookmarked region of video with an image count of 100 
and a time interval of 3 seconds. The resulting export will include the first frame of the bookmarked region followed by 99 additional 
images taken at 3-second intervals. The first exported image will be the first frame of the bookmarked region and the last image will be the 
frame taken at 300 seconds into the bookmarked region.

NOTE:  Audio export is available only with DX8000 Native, AVI, and ASF video formats.

NOTES:

• Real Time setting only applies to DX8000 Native, AVI, and ASF video formats.

• When the Real Time check box is selected, the DX8000 will export video so it can be played back in real time (30 fps) for the same 
length of time as the original recording. For example, if video was recorded at 1 fps, this means the DX8000 will insert 29 null frames 
for every 1 frame of actual video. Thus, one minute of video recorded at 1 fps (60 frames total) will play back for one minute at 
30 frames per second (60 frames of actual video interspersed with 1,740 null frames). If the Real Time check box is not selected, one 
minute of video recorded at 1 fps will play back in two seconds in real time. Figure 119 illustrates the two video streams: one padded 
with null frames to match the actual time duration and another stream without null frames.
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Figure 119.  Real Time Versus Non-Real Time Export

5. Click Export to begin writing video to the device.

Figure 120.  Finalizing the Export Process

STOPPING AN EXPORT WHILE IN PROCESS
When an export operation has begun, a user can easily stop it by interrupting or canceling the operation from the Export menu on the main or 
search screens.  Interrupting an export simply stops the progress of the export while keeping all video information stored up to that point intact. 
Canceling an export will delete any video data exported during the operation as well as ending the export itself.

To halt an export that is in process while retaining video data stored to that point, go to Export > Interrupt Export.

To halt an export that is in process and delete any video data stored to that point, go to Export > Cancel Export.

Figure 121.  Export Menu Options

Null Frame Null Frame Null Frame Null Frame

NULL FRAMES INSERTED TO MATCH CLOCK TIME

NO NULL FRAMES INSERTED

CLOCK TIME
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Printing Images
The printing feature of the DX8000 produces a hard copy of the current on-screen image. The DVR must be placed in Playback or Search mode to 
use the print feature. Playback is paused once the print button is pressed.

To print an on-screen image:

1. Click  or .

2. Locate the video image you want to print. Refer to Playback Mode on page 62 and Search Mode on page 72 for information on locating 
video.

3. Click .

4. Click .

5. Click OK.

PRINTING IMAGES IN THE DEINTERLACED MODE
If you are printing images recorded at 4CIF at a low frame rate per second, the viewed image might move or tear. The View menu’s Deinterlaced 
Image option is used to enhance the image for printing. 

To print an image using the deinteraced option:

1. Click  or .

2. Locate the video image you want to print. Refer to Playback Mode on page 62 and Search Mode on page 72 for information on locating 
video.

3. Click 

4. Click  to freeze the image for printing.

5. Click  to print the image to a designated printer.

NOTE:  A Windows-compatible printer must be installed to take advantage of the DX8000’s print feature. Refer to the installation manual 
that came with your unit for instructions on installing a printer.

TIP:  Use the , , and  buttons to locate the exact image you want to print before clicking .

.
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Setup Mode

SETUP SCREEN
Click  to enter the setup screen.

The setup screen allows Administrators and Power Users access to the DX8000’s setup functions. However, only Administrators can define user 
names and passwords for new users. 

Figure 122.  Setup Screen

	   Click the Camera button to configure cameras. Available options are PTZ functions, motion detection, picture adjustment, and audio 

settings.

�   Click the Linking button to configure relays and alarms, associate relays and alarms with cameras, link relays to alarms, and link 

cameras to other cameras.

�   Click the Schedule button to build custom recording schedules.

�   Click the Network button to view the network configuration. Network setup cannot be changed using the PC Client application.

�   Click the Backup button to view the backup configuration. Backup setup cannot be changed using the PC Client application.

�   Click the User button to add, delete, or change user accounts.

NOTE:  Only a single user with Administrator or Power User access is allowed to access a DX8000’s Setup mode at one time. When 
connected to a network supporting multiple DVRs and/or clients, users with Administrator access override and block Power Users. If two 
users with the same access level attempt to enter Setup mode simultaneously, the DX8000 will allow access to setup features on a first-
come, first-served basis. Unavailable setup options will be grayed-out.

�
�

�
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�   Click the Site Setup button to view the remote site configuration. Site setup cannot be changed using the PC Client application.

�   Click the System button to view the system configuration, to import/export configuration files, and to save or view system logs.

�   Click the Ext. Monitor button to view the external monitor configuration. External monitor setup cannot be changed using the PC 

Client application. (This button appears only if the optional display card has been installed.) 


�   Click the Notification button to configure emergency agent and e-mail notification options. 

The following sections describe each of these setup functions in turn.
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CONFIGURING CAMERAS
Depending on your system’s current configuration, up to 16 video cameras can be connected to a single DX8000. The following section illustrates 
basic camera configuration.

BASIC CAMERA SETUP

To set up camera picture and PTZ features:

1. Click .

2. Click .

3. Select a camera from the drop-down box. 

4. Select the Disable check box if you wish to disable the camera.

5. Enter an optional new name for the camera. Camera names can be up to 32 characters long and can include spaces and special characters.

6. Set camera security level. Available security levels are

• None – Camera can be viewed by all users

• Low – Camera can be viewed by all users except the Guest account

• Medium – Camera can be viewed by users with Standard User access and higher

• High – Camera can be viewed by users with Power User access and higher

Figure 123.  Camera Configuration Screen

NOTE:  You must be logged in as an Administrator or Power User to configure cameras.

TIP:  You can also select a camera from the site tree by clicking on it.

� 
� 
�

�
�

�
�

�

�

C626M-B (3/05) 97DX8000 PC Client Application



7. Select the appropriate PTZ protocol for the camera, or select No PTZ if the selected camera does not support PTZ functions. Available 
protocol options are

• NO PTZ –  Disables all PTZ functions for the current camera 

• PELCO-C – Coaxitron

• PELCO-D – Pelco proprietary

• PELCO-P – Pelco proprietary

8. Select an appropriate “PTZ Locking Auto-timeout” value from the drop-down box. Time out values can be set between 5 and 60 seconds. 
The default value is 10 seconds.

9. Adjust picture properties by moving sliders for Brightness, Contrast, Hue, and Saturation. 

10. Click Default to return all picture property settings to the normal state.

11. Click Apply. 

NOTE:  Because the DX8000 Series DVR is designed to operate in a networked environment, it is possible that multiple users may attempt 
to simultaneously control the PTZ features of a single camera. To minimize potential conflicts, only one user at a time is allowed to control 
the PTZ features of a camera. PTZ control is made available on a first-come-first-served basis. Once a user gains control of a camera’s PTZ 
features, all other users must wait until the controls for that device have been left idle for the amount of time specified in the “PTZ Locking 
Auto-timeout” drop-down box.

NOTE:  As you adjust the picture properties of a camera on the local DVR, changes will be reflected immediately in the view area near the 
top of the screen. Changes made to cameras at a remote site will not appear in the view area until you click the Apply button.

TIP:  You can click the Hide/Show button to clear the view area to get a better look at your picture property changes. Refer to step 2 in 
Motion Detection Setup on page 99.
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MOTION DETECTION SETUP

Up to five motion detection zones can be defined for each camera. When the DX8000 is scheduled to record motion detection, motion sensed in 
the selected zone will result in video data being recorded for that channel. Motion detection can also be used to trigger relays, PTZ presets, and 
recording on multiple cameras. Refer to Schedule on page 110 and Linking on page 102 for more information. 

To define motion detection zones for the selected camera:

1. Select the motion zone (1-5) from the drop-down box.

2. Click the Hide/Show button to either hide or display the motion grid. 

3. Move the Number of Blocks slider to change the grid size of the motion overlay.

4. Define the area for motion detection:

• Click Clear All to remove the currently defined motion detection area.

• Click Select All to enable motion detection for the entire viewable area.

• Hold down the left mouse button and drag to select areas.

• Hold down the right mouse button and drag to deselect areas.

5. Move the Sensitivity slider to adjust motion sensitivity. Moving the slider to the left decreases motion sensitivity, moving the slider to the 
right increases sensitivity.

6. Click Apply.

Figure 124.  Camera Motion Detection Setup
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AUDIO SETUP

To set up audio for a camera:

1. Check the Channel Information section to verify that the audio option is installed and available.

2. Verify that the Audio Disable check box is not selected.

3. Click Apply. 

Figure 125.  Camera Audio Setup

IMPORTANT:  To use the DX8000’s audio features, the optional DX8000-AUD audio card must be installed. Consult your Pelco sales 
representative for more information regarding the DX8000-AUD option.

�
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APPLYING SETTINGS TO ALL CAMERAS

To apply camera configuration options to all attached cameras:

1. Select the check boxes for Protocol, Camera Security, Picture Adjustment, and Motion Detection that you want to apply to all cameras.

2. Click Apply to All Cameras.

Figure 126.  Applying Settings to All Cameras

	

�
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LINKING

CONFIGURING BASIC RELAY AND ALARM SETTINGS

The DX8000 can support up to 16 alarm inputs and relay outputs. Eight-channel DVRs include 8 alarm and 8 relay terminals while sixteen-
channel DVRs include 16 of each. 

To program alarms and relays:

1. Click .

2. Click .

3. Click the Relay and Alarm Settings tab if it is not already visible.

Configuring Basic Relay Settings

To configure a relay output:

1. From the Relay Channel drop-down box, select the relay you want to configure.

2. Enter an optional new name for the relay in the Relay Name text box. Relay names can be up to 32 characters long and can include spaces 
and special characters.

3. Click the NO/NC button to toggle the default output type for each relay (NO – normally open or NC – normally closed).

4. Click Apply.

Figure 127.  Relay Settings

TIP:  You can also rename sites, cameras, alarms, and relays from the site tree by clicking twice slowly on each object’s name.

�

�
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Configuring Basic Alarm Settings

To configure an alarm input:

1. From the Alarm Channel drop-down box, select the alarm input you want to configure.

2. Enter an optional new name for the alarm in the Alarm Name text box. Alarm names can be up to 32 characters long and can include spaces 
and special characters.

3. Click the NO/NC button to toggle the default output type for each alarm (NO – normally open or NC – normally closed).

4. Click Apply.

Figure 128.  Alarm Settings

TIP:  Most applications will not require you to change relay and alarm settings from their default states.

�
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LINKING RELAY OUTPUTS TO MOTION AND ALARM EVENTS

To access relay link settings:

1. Click .

2. Click .

3. Click the Event - Relay Link Settings tab.

Linking Relay Outputs to Motion Events

To set relay outputs to activate in response to motion detection events:

1. Select a camera from the Camera Channel drop-down box.

2. Click the button of each relay you want to link to the selected camera.

3. Click Apply.

Figure 129.  Linking Relays to Motion Events

TIP:  You can also drag relays onto cameras in the site tree while in Live mode (main screen).

�

	

�
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Linking Relay Outputs to Alarm Inputs

To set relay outputs to activate in response to an alarm input:

1. Select an alarm from the Alarm Channel drop-down box.

2. Click the button for each relay you want to link to the selected alarm.

3. Click Apply. 

Figure 130.  Linking Relays to Alarms

TIP:  You can also drag relays onto alarms in the site tree while in Live mode (main screen).

�
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LINKING PTZ PRESETS AND PATTERNS TO MOTION AND ALARM EVENTS
The DX8000 can be configured in such a way that motion detected by one camera will result in the repositioning of another. Similarly, alarm 
inputs can be set to trigger camera-positioning presets. Only a single preset or pattern can be linked to a camera. 

Linking PTZ Presets and Patterns to Motion Events

To link two cameras so that motion detected on one results in the repositioning of another:

1. Click .

2. Click .

3. Click the Event-Relay Link Settings tab.

4. Select a camera from the Camera Channel drop-down box. (This camera will be the motion source.)

5. Select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will change PTZ position in response to motion 
detected by the source camera.)

6. Select a PTZ preset or pattern for the linked camera:

a. To force the linked camera to move to a PTZ preset in response to motion detected by the source camera:

• Select the Linked Camera Preset radio button.

• Select a PTZ preset (1-32) for the camera to move to.

or

b. To force a PTZ pattern to be activated in response to motion detected by the source camera:

• Select the Linked Camera Pattern radio button.

• Select a PTZ pattern (1-4) to be activated on the camera.

7. Click Apply.

Figure 131.  Linking Presets and Patterns to Motion Events

NOTE:  The selected camera must support PTZ functions and at least one PTZ preset/pattern must be defined for this function to work.

�

�
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Linking PTZ Presets and Patterns to Alarm Events

To link an alarm input to a camera so that activation of the alarm results in a repositioning of that camera:

1. Click .

2. Click .

3. Click the Event - Relay Link Settings tab.

4. Select an alarm from the Alarm Channel drop-down box.

5. Select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will change PTZ position in response to an 
alarm input detected by the source alarm.)

6. Select a PTZ preset or pattern for the linked camera:

a. To force the linked camera to move to a PTZ preset in response to an alarm input detected by the source camera:

• Select the Linked Camera Preset radio button.

• Select a PTZ preset (1-32) for the camera to move to.

or

b. To force a PTZ pattern to be activated in response to an alarm input detected by the source camera:

• Select the Linked Camera Pattern radio button.

• Select a PTZ pattern (1-4) to be activated on the camera.

7. Click Apply.

Figure 132.  Linking Presets and Patterns to Alarms

NOTE:  The selected camera must support PTZ functions and at least one PTZ preset/pattern must be defined for this function to work.

�
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LINKING CAMERAS TO RECORD IN RESPONSE TO MOTION AND ALARM EVENTS

Multiple cameras can be configured to begin recording when an alarm is triggered or motion is detected. 

Linking Cameras to Motion Events

To link multiple cameras to record in response to motion detection events:

1. Click .

2. Click .

3. Click the Event - Recording Link Settings tab.

4. Select the source camera that will be used to detect motion from the Motion Source Camera drop-down box.

5. Click the button of each camera you want to begin recording when motion is detected by the source camera.

6. Click Apply.

Figure 133.  Linking Cameras to Motion Events

�
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Linking Cameras to Alarm Events

To link multiple cameras to record in response to a single alarm input:

1. Click .

2. Click .

3. Click the Event - Recording Link Settings tab.

4. Select the alarm that will be used as the event source from the Alarm Channel drop-down box.

5. Click the button of each camera you want to record when the source alarm is triggered.

6. Click Apply. 

Figure 134.  Linking Cameras to Alarms

�
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SCHEDULE
The DX8000 provides extensive scheduling capabilities. Flexible recording schedules can be established for daily, weekday, weekend, or 
individual day recording. Recording time can be broken up into increments of one-half hour, and each increment can be scheduled to record 
continuously or in response to an alarm input or motion detection. Users with Power User access and higher can create recording schedules.

To access the scheduling features of the DX8000, click , and then click .

Figure 135.  Schedule Setup Screen

	 Schedule Type Drop-down Box: Selects the type of schedule. Options are

• All days – Seven days a week

• Weekdays – Monday through Friday, with the exception of any day assigned in Custom mode

• Weekends – Saturday and Sunday, with the exception of any day assigned in Custom mode

• Custom Mode – Any day, such as a holiday

� Recording Schedule Profile: Allows you to do the following:

• Select and apply an existing schedule profile.

• Create and save a new profile.

• Change an existing profile.

• Delete an existing profile.  

� Calendar: Displays current schedule profile in accordance with the schedule type selected (All Days, Weekdays, Weekends, or Custom 
Mode).

� Start and End Time Markers: Sets the start and end points for a custom schedule.

� Record Mode: Selects a recording mode to be applied to a camera. Options are

• Normal

• Motion 

• Alarm

• Event

� Channel Scheduling Panel: Allows the assignment of recording modes across individual camera channels over a 24-hour period.

�

�

�
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� Camera Settings Panel: Allows custom settings to be applied to individual cameras for each recording mode.

� Apply: Click to save current schedule.

� Frame Rate Configuration: Allows configuration of channel resolution and frame rates.


� Configure Relays: Allows configuration of relays that have been linked to cameras and alarms. 

WORKING WITH THE CHANNEL SCHEDULING PANEL

In the channel scheduling panel a user with Power User access or higher can schedule video recording for one or more channels across a 24-hour 
timeline. The panel appears near the bottom of the screen for each scheduling mode.

Figure 136.  Schedule Timeline Grid

To schedule a record mode for one or more channels:

1. Click the check box for the recording mode you want to apply to a channel.

• Normal 

• Motion

• Alarm

• Event

Table D.  Recording Modes

2. Click and drag to highlight the time periods and channels where you want the recording mode to apply.

3. Click Apply.

Mode Color Code Description

Normal Green Continuous recording.

Motion Blue
Recording is triggered during the selected time block if a motion event is 
detected in the camera’s predefined motion field (refer to Motion Detection 
Setup on page 99).

Alarm Red

Recording is triggered during the selected time block when an alarm is 
activated. At least one alarm must be linked to the camera for this option to 
work. (Refer toLinking Alarm Inputs and Relay Outputs to Cameras on 
page 33.)

Event Yellow Recording is triggered during the selected time block in response to any 
motion or alarm event.

TIP:  Because Event recording mode represents both alarm and motion recording, it may at first appear redundant. However, Event record-
ing mode is necessary because it allows recording to occur in response to either a motion or an alarm event. Without Event recording, 
alarm and motion recording would be treated as mutually exclusive. In other words, a schedule could be configured to record only in 
response to an alarm event or only in response to a motion event.

TIP:  Drag the mouse diagonally to highlight periods across multiple camera channels simultaneously.
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Figure 137.  Filling In Recording Blocks in Schedule Grid

To clear scheduled recording from one or more channels:

1. Right-click and drag to highlight the time periods and channels where you want to clear recording times.

2. Click Apply.

Figure 138.  Removing Recording Blocks from Schedule Grid
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CREATING RECORDING SCHEDULES USING THE YEAR VIEW

Year View allows a user to customize recording schedules for individual days. Year View displays daily recording schedules in a calendar format. 
The calendar displays one year’s worth of daily recording schedules. The scheduling period begins in the current month.

• Days circled in red have been assigned weekday, weekend, or everyday recording schedules.

• Days circled in blue have been assigned a custom recording schedule.

• Days without circles denote that no recording has been scheduled for that day.

To schedule individual days using the Year View:

1. Click the Year View tab.

Figure 139.  Year View Page

2. Click the day you want to schedule.

Figure 140.  Calendar Date Selection

3. Using your mouse, select the recording modes and times for each channel you want to schedule. Refer to Working with the Channel 
Scheduling Panel on page 111 for instructions.

Figure 141.  Selecting Recording Modes for Individual Cameras

4. Repeat steps 2 and 3 for each additional day you want to schedule.

5. Click Apply.
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CREATING RECORDING SCHEDULES USING THE MONTH VIEW

Unlike schedules set in the Year View, Month View schedules are recurrent. Schedules can be set for subsequent weekdays, weekends, every 
day, or a single day.

Creating Multiple-Day Schedules

To create a recording schedule to recur indefinitely:

1. Click the Month View tab if it is not currently selected.

2. Select All Days, Weekdays, or Weekends from the drop-down box.

3. Click New. 

Figure 142.  Month View Page

4. Enter a new filename for the profile.
 

5. Click OK.

Figure 143.  New File Name Dialog Box

NOTE:  Profile filenames follow standard Windows file-naming conventions.

�
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6. Using your mouse, select the recording modes and times for each channel you want to schedule. Refer to Working with the Channel 
Scheduling Panel on page 111 for instructions.

7. Click Save.

8. Click Apply.

9. Click the Apply button at the bottom of the screen.

Figure 144.  Selecting Recording Modes for Individual Cameras

�
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Creating Single-Day Schedules

Custom Mode schedules are defined for single days only. A custom-scheduled day can be set to recur on the same day of every month or the 
same day every year.

 To set the DVR to record on a specific day: 

1. Click the Month View tab if it is not currently selected.

2. Select Custom Mode from the drop-down box.

3. Click New.

Figure 145.  Month View Page

4. Enter a new filename for the profile.

5. Click OK.

Figure 146.  New File Name Dialog Box

NOTE:  Profile filenames follow standard Windows file-naming conventions.
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6. Select Once Per Month or Once Per Year.

7. Select the date range for the custom schedule.

a.  Set the start date with the Start spinner buttons.

b. If you want the schedule to recur indefinitely, deselect the Finish on End Date check box.

c. Set the end date with the End spinner buttons.

8. Click the date on the calendar you want to schedule.

9. Select the recording modes and times for each channel you want to schedule. Refer to Working with the Channel Scheduling Panel on 
page 111 for instructions.

10. Click Save.

11. Click Apply.

12. Click the Apply button at the bottom of the screen.

Figure 147.  Selecting Date

NOTE:  The start date cannot be set later than the end date.
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To copy the schedule attributes of one day and apply them to a different day:

1. Right-click the calendar day you want to copy.

2. Select Copy from the quick-menu.

Figure 148.  Month View Calendar Quick-Menu

3. Right-click the day on the calendar day you want to apply the copied schedule attributes.

4. Select Paste from the quick-menu.

5. Click the Apply button at the bottom of the screen.

TIP:  To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the quick-menu.
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CHANGING AN EXISTING SCHEDULE PROFILE

To change a profile:

1. Click the Month View tab if it is not currently selected.

2. In the drop-down box, select the type of schedule you want to change. Options are

• All Days

• Weekdays

• Weekends

• Custom Mode

3. Select the schedule profile from the drop-down box.

4. Using your mouse, assign new recording modes and times for each channel you want to schedule. Refer to Working with the Channel 
Scheduling Panel on page 111 for instructions.

5. Click Save.

6. Click Apply.

7. Click the Apply button at the bottom of the screen.

Figure 149.  Month View Page
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DELETING AN EXISTING SCHEDULE PROFILE

To delete a schedule profile:

1. Click the Month View tab if it is not currently selected.

2. In the drop down box, select the type of schedule you want to change. Options are

• All Days 

• Weekdays

• Weekends

• Custom Mode

3. In the drop-down box, select a profile that is different from the one you want to delete. (This step is necessary because you cannot delete a 
schedule profile that is currently active.)

4. Click Apply.

Figure 150.  Month View Page
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5. In the drop-down box, select the profile that you want to delete.

6. Click Delete.

7. Click Apply. 

Figure 151.  Deleting Schedule Profile

�
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CONFIGURING CUSTOM CAMERA SETTINGS

Each camera channel can be configured with custom recording settings.

To customize channel settings for normal, motion, or alarm recording:

1. Click .

2. Click .

3. Click the plus (+) sign next to a camera in the site tree.

4. Select a recording mode for the camera. Options are

• Normal

• Motion

• Alarm

• Event

5. Adjust the parameters in the camera settings panel.

6. Click Apply.

NOTE:  Event mode includes both motion and alarm events.

�

�

�

Figure 152.  Custom Camera Settings Panel
122 C626M-B (3/05)DX8000 PC Client Application



 

Table E.  Custom Camera Settings

*This field appears for information purposes only. To change this setting, refer to Configuring Frame Rate on page 124.

**Image quality is a function of video compression. Higher quality video images require larger file sizes.

Normal Recording Settings Motion Recording Settings Alarm Recording Settings Event Recording Settings

Image Resolution* Image Resolution* Image Resolution* Image Resolution*

Frame Rate* Frame Rate During Motion* Frame Rate During Alarm* Frame Rate During Event*

Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Pre-Motion Frame Rate Pre-Alarm Frame Rate Pre-Event Frame Rate

Pre-Motion Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Pre-Alarm Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Pre-Event Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Motion Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Alarm Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Event Image Quality** 
(Best, High, Normal, Low, 
Lowest)

Pre-Motion (1-60 sec) Pre-Alarm (1-60 sec) Pre-Event (1-60 sec)

Post-Motion (1-180 sec) Post-Alarm (1-180 sec) Post-Event (1-180 sec)

Figure 153.  Normal 
Recording

Figure 154.  Motion 
Recording

Figure 155.  Alarm 
Recording

Figure 156.  Event 
Recording
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CONFIGURING FRAME RATE

The DX8000 can record at frame rates up to 480 images per second (ips) NTSC and 400 ips PAL. This total frame rate capacity is distributed 
among eight or sixteen channels, depending on the configuration of your unit. Resolution and frame rate values can be assigned evenly among all 
channels or can be configured independently for individual channels. Frame rate values can also be customized according to recording mode type 
(normal, alarm, or motion). 

Two setup modes are provided to allow Power Users and Administrators to configure recording frame rates on the DX8000. All channels are 
optimized to provide 30 ips frame rates at 320 x 240 resolution NTSC (352 x 288 resolution PAL). Basic mode allows changes to be made in the 
frame rates available to each channel, while resolution values must remain constant. Advanced mode allows users to change both frame rate 
and resolution settings. 

To access the frame rate configuration screen:

1. Click .

2. Click .

3. Click Frame Rate Configuration.

Figure 157.  Frame Rate Configuration Button

�
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Configuring Basic Frame Rate

The DX8000 Series DVR is optimized to provide sixteen channels of continuous video recording with a frame rate of 30 ips at a resolution of 
320 x 240 (NTSC). Basic mode allows only frame rate adjustments to be made. 

To set frame rate values for channels in Basic mode: 

1. Select the radio button of the recording mode you want to configure. Options are

• Normal

• Motion

• Alarm

2. Using the slider, select a frame rate from 1 to 30 ips for the desired channel.

3. Repeat steps 1 and 2 for each channel you want to configure.

4. Click OK.

5. Click Apply when you return to the Schedule Setup screen.

Figure 158.  Basic Frame Rate Configuration Screen

NOTE:  Eight-channel DVRs only have eight sliders.

��
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Configuring Advanced Frame Rate

Both resolution and frame rate settings can be adjusted in Advanced Frame Rate Configuration mode. 

To set recording resolution and frame rates for each channel: 

1. Click Advanced to access the advanced frame rate configuration controls.

Figure 159.  Accessing Advanced Mode

2. Select the radio button of the recording mode you want to configure. Options are

• Normal

• Motion

• Alarm

3. Select resolution values for individual channels from the drop-down boxes. Refer to Table F.

Table F.  Resolution Values

4. Using the Maximum Frame Rate Settings sliders, set the maximum frame rate for each resolution.

5. To set a global frame rate for all channels of a particular resolution type, move the slider under Global Frame Rate Settings. Select a frame 
rate from 1 to 30 ips according to the available capacity for that resolution.

6. To set the frame rate for individual channels, use the sliders in the top portion of the screen. Select a frame rate from 1 to 30 ips according 
to the available capacity for that channel.

NTSC PAL

320 x 240 352 x 288

640 x 240 704 x 288

640 x 480 704 x 576

720 x 240 720 x 288

720 x 480 720 x 576

NOTE:  Setting a resolution  value for one recording mode sets the resolution value for all modes. For example, setting resolution to 
640 x 480 in Motion recording mode will change the resolution to 640 x 480 in Normal and Alarm recording modes as well.

NOTE:  Setting the maximum frame rate for a resolution will impose a limit on how high frame rates can be set on individual channels 
using that resolution. In certain cases, setting a lower maximum frame rate for a particular resolution may free up resources to be used by 
channels set at another resolution. In any case, frame rates cannot be set for any channel or resolution beyond the availability calculated by 
the DX8000.
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7. Click Default to set the Maximum Frame Rate Settings values back to their factory defaults.

8. Click OK.

9. Click Apply when you return to the Schedule Setup screen.

Figure 160.  Advanced Frame Rate Configuration Screen
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Understanding the DX8000’s Frame Rate Calculations

The DX8000 uses a complex algorithm to calculate the amount of recording resources available for each channel. This calculation takes into 
account factors such as the number of enabled cameras, whether uniform or mixed resolution values are used, recording type (continuous, 
alarm, or motion), and the frame rate settings of enabled channels. The resulting calculations provide the operator with a margin of available 
frame rate capacity to distribute among the recorder’s channels. This margin of frame rate capacity, or “headroom,” is presented to the user as 
color-filled sections of the frame rate sliders. White areas on the slider represent frame rate capacity that is not available to that channel. In 
certain cases, adjusting the available frame rates of one channel or resolution type may free up capacity for other channels. Refer to the 
example in Figure 161. 

Figure 161.  Frame Rate Capacity Example

AVAILABLE
FRAME RATE

CAPACITY

UNAVAILABLE
FRAME RATE

CAPACITY
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CONFIGURING ADVANCED RELAY OUTPUT

Relays work much like switches. When triggered, relays can activate external devices, such as sirens, light fixtures, and door locks. The DX8000 
PC Client Application allows Administrators and Power users to link relays to cameras and alarms. Up to 20 seconds of delay can be set from the 
moment an event is triggered to the time when a relay is activated.

To configure a relay output:

1. Click .

2. Click .

3. Click the Configure Relays button.

Figure 162.  Custom Camera Settings Panel

NOTE:  Make sure you have linked relays to the appropriate cameras and alarm inputs before attempting to configure them. For instruc-
tions on linking alarms and relays, refer to Linking Alarm Inputs and Relay Outputs to Cameras on page 33 and Linking Relay Outputs to 
Alarm Inputs on page 36.

�
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4. Click the Alarm Activated Relay Settings tab if it is not already selected.

5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay timing value from the Activation Period drop-down box. Options are listed in Table G.

Figure 163.  Linking Relays to Alarms

Table G.  Alarm-Activated Relay Settings

Option Result

Disable Relay will not activate when the alarm is triggered.

Follow Event Relay will activate at the exact same time the alarm is triggered.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the alarm has been 
triggered.

5b

5a�
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6. Click the Motion Activated Relay Settings tab.

7. Configure each relay that is linked to a camera:

a. Click the drop-down box to select a relay.

b. Select a relay timing value from the Activation Period drop-down box. Options are listed in Table H.

8. Click Save.

9. Click Exit. 

Figure 164.  Linking Relays to Motion Detection

Table H.  Motion-Activated Relay Settings

Option Result

Disable Relay will not activate when the motion is detected.

Follow Event Relay will activate at the exact same time motion is detected.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after motion has been 
detected..

7b

�
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NETWORK AND COMMUNICATIONS SETUP

BACKUP CONFIGURATION
The DX8000 PC Client application allows you to see backup configuration settings but not change them. To configure and perform backups, you 
must physically log in to a local DX8000 Series DVR as an Administrator or Power User. For more information configuring a backup schedule, refer 
to Backup Configuration in the Operation and Programming manual.

You must use the DX8000 PC Client application to view and search backed up video. For more information about viewing backed up video, refer 
to Viewing and Searching Backed Up Video on page 80. 

MANAGING USERS
The user configuration screen allows an Administrator to add, delete, and change the properties of users. Users are subdivided into groups and 
each group is granted a particular level of access. 

BUILT-IN USER ACCOUNTS

There are two built-in user accounts that come preconfigured on the DX8000 and cannot be deleted or changed.

Guest – The Guest account provides limited access to the system. The Guest user can view live video but cannot play back recorded video or 
access system configuration functions. The Guest account automatically becomes active when the system is first started and each time a user 
logs out. The Guest user is not a member of any group; however, Guest retains all of the rights and privileges of the Restricted Users group with 
the exception of the ability to view low security cameras.

Admin – The administration (Admin) account has full access to the system. The Admin user can view live and playback video, access all 
configuration settings, add and modify users, and perform searches and backups. The Admin user is a member of the Administrators group and 
cannot be removed.

DEFINITION OF USER ACCESS LEVELS

There are four predefined user access levels or groups. User access levels range from the Administrator group to the Restricted group. The 
system always starts up with a default Guest account. The Guest account has Restricted user access. Table I defines user groups and 
corresponding access levels.

Table I.  User Group Access Rights

NOTE:  Network settings cannot be changed from the DX8000 PC Client application. To change a DVR’s network configuration, you must 
physically log in to a local DX8000 Series DVR as an Administrator or Power User. For more information on configuring the DX8000’s 
network settings, refer to the Operation and Programming manual that came with your unit.

NOTE: Video cannot be backed up, nor can backup settings be changed, from the DX8000 PC Client application.

User Groups
View 
Live 

Video

View 
Recorded 

Video

Operate 
PTZ

Search 
Video

Backup 
Video

System
Setup

Shut 
Down

System

Add/
Remove 

Users

Change 
User/Group 
Properties

Exit to 
Windows

Administrators 9 9 9 9 9 9 9 9 9 9

Power Users 9 9 9 9 9 9 9

Standard Users 9 9 9 9

Restricted Users 9

Guest Users 9
C626M-B (3/05) 131DX8000 PC Client Application



DEFINITION OF CAMERA SECURITY ACCESS

Users are limited in the cameras they are allowed to view. Access to a camera is determined by its security designation. Only users with High 
Security access, such as Administrators and Power Users, can view cameras designated as High Security. Medium Security cameras can be 
viewed by users with Medium Security access and higher. All users except Guest can view Low Security cameras. All users can view No Security 
cameras. Table J below summarizes camera security levels and user access.

Table J.  Default Camera Viewing Security 

Groups No Security 
Cameras

Low 
Security 
Cameras

Medium 
Security 
Cameras

High 
Security 
Cameras

Administrators 9 9 9 9

Power Users 9 9 9 9

Standard Users 9 9 9

Restricted Users 9 9

Guest Users 9
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ADDING NEW USERS

Administrators can create new user accounts and modify existing users. 

To add a new user:

1. Click .

2. Click .

Figure 165.  Adding a User

3. Click Add.  The Add New User dialog box opens.

Figure 166.  Add New User Dialog Box

�

�
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�
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4. Enter a login name for the user. (User names can be between 4 and 20 alphanumeric characters in length. User names cannot contain 
spaces and special characters.)

5. Enter the user’s full name.

6. Enter a brief description for the user: Building 6 Security Guard as an example.

7. Enter a password for the user. (Passwords must be between six and ten characters in length and cannot contain spaces and special 
characters.)

8. Re-enter the same password to confirm its validity.

9. Click Next. The access level screen of the New User dialog opens.

10. Select the user’s access level: Restricted, Standard, or Power.

11. Click Finish.

12. Click the Apply button at the bottom of the screen.  

Figure 167.  New User Access Level Dialog Box

NOTE:  User names and passwords are case-sensitive.


�


�
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MODIFYING USER PROPERTIES

Follow the steps below to change user attributes, such as user name and group affiliation. Only Administrator level users are allowed to modify 
user properties.

To modify a user’s properties:

1. Click a user name in either the main user list or in one of the group lists.

2. Click Properties.

Figure 168.  Modifying User Properties

	

�
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3. Edit the following user properties:

• User name

• Full name

• Description

• Group

4. Click Apply in the Property dialog box.

Figure 169.  Property Dialog Box

5. Click Apply in the User Setup screen.

Figure 170.  Drag and Drop of User Group Affiliation

NOTE:  Users with Administrator or Power User access can change name and description properties of lower-level users. Only Administrator 
level users, however, can change a user’s group affiliation.

TIP:  An Administrator level user can also change the group affiliation of users by dragging-and-dropping user names among different 
groups.

�

�
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CHANGING USER PASSWORDS

Administrators and Power Users can change or reset an existing user’s password.

To change a user’s password:

1. Click a user name in the main user list.

2. Click Set Password.

Figure 171.  Changing a Password

3. Enter a new password in the “New password” field.

4. Retype the password again in the “Confirm new password” field.

5. Click Apply in the Set Password dialog box.

Figure 172.  Set Password Dialog Box

6. Click Apply in the User Setup screen. 

NOTE:  Passwords are case-sensitive.

	

�

�

�
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DELETING EXISTING USERS

Administrators can delete existing users.

To delete a user’s account:

1. Click the user name of the user you want to delete from the main user list.

2. Click Remove.

Figure 173.  Deleting a User

3. Click Yes to confirm the deletion or No to cancel and return to the User Setup screen.

Figure 174.  Remove User Dialog Box

4. Click the Apply button at the bottom of the screen.

	

�
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SETTING LOGIN TIMEOUT

Administrators can define the amount of time a user’s account can remain idle before having to log in again. This setting applies to all users, 
regardless of access level. 

 To set login time out:

1. Select a time limit from the User Timeout drop-down box.

• Time limits range from five minutes to one hour, in five-minute increments.

• Selecting Manual from the drop-down box will suspend the automatic logout feature. (A user will remain logged in until the user logs 
out or another user logs in.)

2. Click Apply.

Figure 175.  Setting Login Timeout

	

�
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SITE SETUP

SYSTEM SETUP

IMPORTING AND EXPORTING SYSTEM SETUP FILES

Users with Power User access and higher can save configuration settings for the DX8000 using the system export feature. Previously saved 
settings can be loaded into the DVR using system import.

1. Click .

2. Click .

Figure 176.  System Setup Screen

NOTE:  The Site Setup option cannot be configured from the DX8000 PC Client application. To modify this option, you must physically log in 
to the local DX8000 Series DVR as an Administrator or Power User. For more information on configuring the Site Setup option, refer to the 
Operation and Programming manual that came with your unit.

NOTE:  Many of the options presented in the system setup screen cannot be configured from the DX8000 PC Client application. 
Administrators and Power Users are allowed to import and export system configuration files and to view and export system logs. To modify 
other system setup options, you must physically log in to the local DX8000 Series DVR as an Administrator or Power User. For more 
information, refer to the Operation and Programming manual that came with your unit.
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Exporting Current DVR Settings

To save current DVR configuration settings:

1. Select the Export radio button.

2. Select the check boxes of each configuration item you want to back up, or click Select All to export all settings.

3. Enter drive, path, and filename information into the text box (for example: C:\ DX8000 \ Jan_2004_config).

4. Click Export Now.

Figure 177.  Exporting DVR Settings

To save current DVR settings by browsing for the appropriate drive and folder:

1. Select the Export radio button.

2. Select the check boxes of each configuration item you want to back up, or click Select All to export all settings.

3. Click Browse.

Figure 178.  Selecting Export Item

NOTE:  Settings filenames follow standard Windows file-naming conventions.

� �

�

	

	 � ��
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4. Enter a filename in the space provided.

5. Select the folder where you want to save the settings file.

6. Click the Up button to move up a level in the folder hierarchy.

7. Click Save.

8. Click Export Now.

Figure 179.  Setup File Export Dialog Box

Importing DVR Settings

To import a saved settings file:

1. Select the Import radio button.

2. Enter drive, path, and filename information into the “Look in” text box (for example: C:\System Settings Backup 1).

3. Click Import Now.

4. Click the Apply button at the bottom of the screen.

Figure 180.  Import Configuration

NOTE:  Settings file filenames follow standard Windows file-naming conventions.

� �
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To import a settings file from a specific drive or folder:

1. Select Import radio button.

2. Click Browse.

3. Select the folder where the settings file is located.

4. Click the Up button to move up a level in the folder hierarchy.

5. Select the settings file you want to open.

6. Click Open.

7. Click Import Now.

8. Click the Apply button at the bottom of the screen.

Figure 181.  Selecting Import Item

Figure 182.  Setup File Import Dialog Box
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Exporting and Importing Settings Using the Edit Menu

To save current DVR settings:

1. Go to Edit > Export Setup.

2. Select the folder where you want to save the settings file.

3. Click the Up button to move up a level in the folder hierarchy.

4. Enter a filename in the space provided.

5. Click Save.

Figure 183.  Export Configuration Dialog Box

�
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To import a settings file from a specific drive or folder:

1. Go to Edit > Import Setup.

2. Select the folder where you want to save the settings file.

3. Click the Up button to move up a level in the folder hierarchy.

4. Click the settings file you want to open.

5. Click Open.

Figure 184.  Setup File Import Dialog Box 

�
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SYSTEM LOGS

The DX8000 automatically stores system information in a number of log files. Users with Power User access and higher can use these files to 
track system statistics and monitor security.

Viewing a Log

To view a system log file:

1. Select a log file from the drop-down box. The following are the available log files: 

• System On/Off

• System Failure

• Export

• Back-up

• Network Connection

• Login ID List with Time

2. Click View.

Figure 185.  Viewing a Log File

3. Click OK to close the Log Viewer window.

Figure 186.  Log Viewer Dialog Box

NOTE:  You cannot clear system logs from the PC Client application.

	 �
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Exporting Log Information

To export a system log file:

1. Select a log file from the drop-down box. 

2. Click Save As.

Figure 187.  Exporting a Log File

3. Select the drive and folder where you want to store the log file.

4. Enter a filename for the log information in the space provided.

5. Click Save.

Figure 188.  Log Info Save As Dialog Box

NOTE:  Log file filenames follow standard Windows file-naming conventions.

TIP:  Log files can be opened and printed using a text editing program, such as Windows Notepad.

�

� �

�

C626M-B (3/05) 147DX8000 PC Client Application



EXTERNAL MONITOR SETUP

EMERGENCY NOTIFICATION SETUP
The Emergency Agent Notification alerts selected clients of motion and alarm events detected by DX8000 server sites. When a motion or alarm 
event is triggered, a pop-up window opens on the monitor of the remote site client. The window displays one or more still images taken during 
the event. 

Users with Power User access and higher can configure the emergency agent notification system. The first step in the setup process requires that 
clients be added to the emergency agent notification list. To complete this step, you must provide a valid name and the IP address of each client 
PC. After clients have been added they can be linked to one or more cameras. Finally, the amount of time a server sends images after an event 
occurs and the interval between sending each image must be set. 

ACCESSING THE EMERGENCY AGENT NOTIFICATION SETUP

To access the Emergency Agent Notification setup:

1. Click .

2. Click .

NOTE:  The external monitor settings of a remote DVR cannot be changed from the DX8000 PC Client application. To change a DVR’s analog 
monitor configuration, you must physically log in to a local DX8000 Series DVR as an Administrator or Power User. For more information on 
configuring the DX8000’s optional analog monitor outputs, refer to the Operation and Programming manual that came with your unit.

IMPORTANT:  Before configuring the Emergency Agent Notification, make sure the Emergency Agent Client utility is installed on one or 
more client PCs. Refer to Installing the Client Emergency Agent Application on page 173.
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ADDING CLIENT EMERGENCY AGENTS TO BE NOTIFIED

To add clients to the Emergency Agent Notification list:

1. Click Add to add a client to the emergency notification list.

Figure 189.  Emergency Agent Setup Screen

2. Enter a name for the client. (Client names can be up to 63 characters and can include spaces and special characters.)

Figure 190.  Agent Setup Dialog Box

	

�
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3. Enter the client’s IP address.

4. If necessary, enter a port number in the Agent Port text box. (The default port number is 9004.)

5. Click OK.

6. Click the Apply button at the bottom of the screen.

CHANGING CLIENT EMERGENCY AGENT PROPERTIES

To change an existing client’s information in the emergency notification list:

1. Select a client from the list.

2. Click Edit.

Figure 191.  Selecting an Agent to Modify

NOTE:  Unless there is a conflict on your network, it is recommended that you do not change port numbers from their default values. Make 
sure any changes to port numbers are made consistently across all DX8000 servers and clients on a network. Client and server ports must 
be identical.

	

�
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3. Enter a new name for the client. (Client names can be up to 63 characters long and can include spaces but not special characters.)

4. Enter a new IP address for the client.

5. If necessary, enter a port number in the Agent Port text box. (The default port number is 9004.)

6. Click OK.

7. Click the Apply button at the bottom of the screen.

Figure 192.  Editing Emergency Agent Properties

NOTE:  Unless there is a conflict on your network, it is recommended that you do not change port numbers from their default values. Make 
sure any changes to port numbers are made consistently across all DX8000 servers and clients on a network. Client and server ports must 
be identical. 
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REMOVING CLIENTS FROM THE NOTIFICATION LIST

To delete a client from the emergency notification list:

1. Select a client from the list.

2. Click Delete.

3. Click Apply.

After clients have been added, cameras must be configured to notify individual clients of an event. A single camera can be linked to one or more 
client emergency agents. 

Figure 193.  Deleting an Emergency Agent from Notification List

	

�
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LINKING CAMERAS TO CLIENT EMERGENCY AGENTS

Up to 32 IP addresses can be assigned to each camera. The DX8000 can transmit images up to 10 IP addresses simultaneously. 

To link a camera to one or more clients:

1. Click a camera button (Camera 1 to Camera 16).

Figure 194.  Linking Cameras to Emergency Agents

2. Select the check box of each client site you want to notify when a motion or alarm event is detected by this camera.

Figure 195.  Assigning Cameras to Agents

3. Repeat steps 1 and 2 for up to sixteen cameras on the current site.

4. Click the Apply button at the bottom of the screen.

	

�

C626M-B (3/05) 153DX8000 PC Client Application



After clients have been added and linked to cameras, you must set the amount of time a server sends images after an event occurs and the 
interval between sending each image. 

1. Enter the amount of time in seconds that you want the DX8000 to continue sending still images after an alarm or motion event has been 
detected.

2. Enter the time interval in seconds that you want the DX8000 to wait between sending each still image.

3. Click Apply.

Figure 196.  Setting Duration and Interval for Image Delivery

	

� �
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EMERGENCY E-MAIL NOTIFICATION SETUP 
The DX8000 can be configured to send e-mail notifications alerting users of motion and alarm events. Users with Power User access and higher 
can configure e-mail notification. Notifications can be sent to a single e-mail address or a group of addresses either immediately after an event 
occurs or periodically according to a predefined schedule. You can configure up to 32 e-mail groups. Up to 32 members can be assigned to each 
e-mail group.

Before sending notifications, you must provide information about your e-mail server and establish what events, motion and/or alarm, you want to 
include in the e-mail message. Timing and frequency of the e-mail notifications must also be set. You should test the e-mail notification function 
immediately after configuration to ensure your system is set up correctly.

ACCESSING THE EMERGENCY E-MAIL NOTIFICATION SETUP

To access the emergency e-mail notification setup:

1. Click .

2. Click .

3. Click the Emergency E-mail Notification Setup tab.

Figure 197.  E-Mail Notification Setup

IMPORTANT:  To use emergency e-mail notification, the DX8000 Series DVR must be connected to a local area network (LAN) that main-
tains an SMTP mail server. The network must also be connected to either an intranet or the Internet depending on the location of the e-mail 
accounts to which you want to send notifications. Consult your network administrator for information on configuring e-mail notification on 
your local network.

�
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CONFIGURING EMERGENCY E-MAIL NOTIFICATION

To disable emergency e-mail notification, select the Disable Notification radio button.

To enable emergency e-mail notification, select the Enable Notification radio button.

Setting Up E-Mail Server

To configure e-mail server information:

1. Enter a name in the Full Name text box. You should enter a name that reflects the DX8000 server sending the notification; for example, 
DX8000 First Floor Lobby. (Names can be up to 31 characters long and can include spaces but not special characters.)

2. Enter your e-mail address in the E-mail Address text box.

3. Enter the address of your local SMTP mail server. Obtain this information from your network administrator.

4. If your e-mail server requires you to log in, perform the following operations:

• Select the check box labeled My E-mail Server Requires Authentication.

• Enter your e-mail server address.

• Enter your user name. (User names can be up to 31 characters in length and cannot include spaces or special characters.)

• Enter your password. (Passwords can be up to 19 characters in length and cannot include spaces or special characters.)

5. Click Apply. 

Figure 198.  Basic E-Mail Notification Setup

�
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Testing E-Mail Notification

To test e-mail notification:

1. Select the My E-mail Server Requires Authentication check box if it is not already selected.

2. Enter your personal e-mail address or the address of someone who can verify the receipt of the test e-mail in the To text box.

3. Enter DX8000 E-mail Notification Test in the Subject text box.

4. Enter the following server settings if necessary: 

• Server address (This address should be the same as the SMTP server address you entered above.)

• User name

• Password

5. Click Test E-mail Notification.

The DX8000 can be configured to send e-mail notifications on a periodic basis, such as once every ten minutes. 

Figure 199.  E-Mail Test

�

	

�

�

�

C626M-B (3/05) 157DX8000 PC Client Application



Configuring E-Mail Notification Frequency

Depending on the volume of motion and alarm events that are detected by the DX8000, the number of e-mail notifications can be far too many to 
manage effectively. To keep the number of e-mails sent by the DX8000 at a manageable level, the e-mail notification frequency can be adjusted. 
When events have been detected, e-mail notifications can be sent out in intervals from once per minute up to once every six hours. If no events 
have been detected during the specified frequency interval, no notification will be sent. Each e-mail notification will include information about 
the first event detected during the interval, the last event detected during the interval, and a still image (in JPEG format) of the last event.

To configure notification frequency, select the frequency interval from the drop-down box. Options are sending an e-mail notification once every

• 1 minute

• 10 minutes

• 30 minutes

• 1 hour

• 3 hours

• 6 hours

Figure 200.  Setting E-Mail Frequency

To set the time of day during which e-mail notifications will be sent:

1. Select the check box next to Start in Figure 200.

2. Use the spinner buttons or key in the earliest time of day you want e-mail notifications to be sent (for example, 7:30 AM). 

3. Use the spinner buttons or key in the latest time of day you want e-mail notifications to be sent (for example, 6:00 PM). 

4. Click the Apply button at the bottom of the screen.

Figure 201.  Notification Time Window

�
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E-mail notifications can be sent whenever a camera attached to a DX8000 detects motion or when an alarm input is activated. 

To cause e-mail notifications to be sent in response to motion events:

1. Select the Motion check box.

2. Click once in the Selected Channels field to the right of the word “Motion.” The Selected Channels dialog box opens.

Figure 202.  E-Mail Notification for Motion

3. Select the check box of each channel you want to monitor for motion detection events.

4. Click OK.

5. Click the Apply button at the bottom of the screen.

Figure 203.  Motion Event Selected Channels Dialog Box

TIP:  Click Select All to monitor all channels for motion detection. Click Deselect All to deselect all channels.

�	
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To cause e-mail notifications to be sent in response to alarm on events:

1. Select the Alarm check box.

2. Click once in the Selected Channels field to the right of the word “Alarm.” The Selected Channels window opens.

Figure 204.  E-Mail Notification for Alarms

3. Select the check box of each channel you want to monitor for alarm events.

Figure 205.  Alarm Event Selected Channels Dialog Box

4. Click OK.

5. Click the Apply button at the bottom of the screen.

TIP:  Click Select All to monitor all channels for alarm activation. Click Deselect All to deselect all channels.

	 �
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Setting Up E-Mail Notification Groups

To send an emergency notification to multiple users, groups can be created. The DX8000 supports the creation of up to 32 e-mail notification 
groups. A group can be notified in response to an alarm or motion detection event.

To create, change, or delete an e-mail notification group, click the Manage Groups button in the Emergency E-mail Notification Setup screen. 
The Group Management dialog box opens.

Figure 206.  Group Management Dialog Box

Creating and Changing E-Mail Groups

To add a new group:

1. Click Add Group. The Manage Groups dialog box opens.

Figure 207.  Adding E-Mail Group

2. Enter the name of the group (group names can be up to 32 characters in length and can include spaces but not special characters.)

3. Click OK.

4. Click Close.

5. Click the Apply button at the bottom of the screen.

�
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To change a group name:

1. Select a group from the list.

2. Click Edit Group.

Figure 208.  Editing E-Mail Group

3. Enter a new name for the group.

4. Click OK.

Figure 209.  Manage Groups Dialog Box 

5. Click Close.

6. Click the Apply button at the bottom of the screen.

�	
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Deleting E-Mail Groups

To delete a group:

1. Click Manage Groups.

2. Select a group from the list.

3. Click Delete Group.

4. Click Close. 

5. Click the Apply button at the bottom of the screen.

Figure 210.  Deleting E-Mail Group

�

�

�
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Adding Members to an E-Mail Group

Up to 32 members can be assigned to each e-mail group.

To add e-mail addresses to a group:

1. Select a group name from the drop-down box.

2. Ensure that the group check boxes under To and CC are unchecked.

3. Enter an e-mail address in the To or CC text boxes.

4. Click Add to Group.

5. Click the Apply button at the bottom of the screen.

Figure 211.  Adding User to E-Mail Group

	

�

�

�
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Deleting Members from an E-Mail Group

To delete a user from a group:

1. Select a group name from the drop-down box.

2. Select the user you want to delete from the list.

3. Click Delete.

4. Click the Apply button at the bottom of the screen.

Figure 212.  Removing User from E-Mail Group

Changing E-Mail Group Member Attributes

To change a user’s e-mail address or group affiliation:

1. Select a group name from the drop-down box.

2. Select from the list the user you want to edit.

3. Click Edit. The e-mail settings dialog box opens.

Figure 213.  Selecting Group Member

	

�

�

	

�

�
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4. Select a different group for the user from the drop-down box.

5. If necessary, enter a new e-mail address for the user in the text box.

6. Click OK.

7. Click the Apply button at the bottom of the screen.

Figure 214.  E-Mail Settings Dialog Box

�

�

�
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Sending E-Mail Notifications to Individuals

To configure e-mail notification to send alerts to an individual:

1. Enter the e-mail address of the individual to whom you would like to send e-mail notifications in the To text box.

2. Enter an optional e-mail address of a second person you would like to send a copy of the notification to in the CC text box.

3. Enter text for the subject line that will appear in the e-mail notification in the Subject text box. (The default subject line is DX8000 
Emergency Image Notification).

4. Click Apply.

Figure 215.  Sending E-Mails to Individuals

	

�

�
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Sending E-mail Notifications to Groups

To configure e-mail notification to send e-mail alerts to a group of individuals:

1. Select the check box under To.

2. From the drop-down box, select the group to which you want to send event notifications. 

3. Select the check box under CC if you want to e-mail a copy of the event notification to another group of users.

4. Select the group you want to CC from the drop-down box.

5. Click Apply.

Figure 216.  Sending E-Mails to Groups

�

	

�
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Updating the DX8000 Server and Client Applications
From time to time, software updates may be made available for both the DX8000 server and client applications. These updates will be free and 
will be made available on compact disc from Pelco. When an update is issued, it will need to be loaded onto a single DX8000 Series DVR server. 
Once installed on a server, the updates can be automatically distributed to clients on the same network. Remote DX8000 severs can be updated 
from a local DVR using the Software Upgrade utility.

To start the update process:

1. Go to File > Software Upgrade.

Figure 217.  Software Upgrade Server Console

2. The Upgrade Package Select dialog box opens.

Figure 218.  Upgrade Package Select Dialog Box

3. Click Browse. The Upgrade Package Open dialog box opens.
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Figure 219.  Upgrade Package Open Dialog Box

4. Click the “Look in” drop-down box to select the drive and folder location where the settings file resides. 

5. Select the update file you want to open.

6. Click Open. The Upgrade Package Select dialog box reappears.

Figure 220.  Upgrade Package Information

7. Click Next. The Select Server dialog box opens.

NOTE:  The Select Server dialog box displays a list of all connected DX8000s including the local DVR. The PC Client cannot update itself; 
it can only update remote servers. Refer to Automatic System Upgrade on page 18 for information on updating the PC Client application.

�

�

�
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8. To update a remote DVR, select its site name from the Select Server list and then click Connect. Refer to Figure 221.

Figure 221.  Selecting a Remote DVR to Update

9. Click Next and wait for the upgrade utility to copy the necessary files to the selected DVR.

10. At the completion of the update process, a dialog box will appear informing you that the software has been updated successfully. 
The dialog box will also prompt you to update another server if desired. The options are

• Click Yes to select another server to update.

• Click No to finish the update process.

Figure 222.  Upgrade Confirmation Dialog Box

NOTE:  The DX8000 PC Client application can only upgrade remote servers. Do not select local DVR from the Select Server dialog box.

NOTE:  The remote server will reboot 30 seconds after the upgrade process has been completed.
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DX8000 Client Emergency Agent

Setting Up and Using the Client Emergency Agent

DESCRIPTION
The DX8000 Client Emergency Agent works with networked DVRs to alert users when one or more particular channels detect a motion and/or 
alarm event. The Emergency Agent runs on a networked client PC. 

1. You must install the Client Emergency Agent software on your client PC before you can use it. Refer to the installation manual for 
instructions on installing the Client Emergency Agent utility.

2. The DX8000 server must be turned on and operating.

3. Both the DX8000 server and client must be connected to the same network.

4. The Emergency Agent Notification system must be operating on the DX8000 server. 

5. The client PC must be listed in the emergency agent notification list of the DX8000 server and at least one camera must be linked to the 
client. Refer to Emergency Notification Setup on page 148 of this manual or the Operation and Programming manual for instructions.

6. The Client Emergency Agent must be configured and activated on the client PC.

INSTALLING THE CLIENT EMERGENCY AGENT APPLICATION
1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8000 Resource CD into the CD-ROM drive of your PC and wait for the DX8000 Resource CD screen to appear.

Figure 223.  Resource CD Screen: Emergency Agent Installation Option

IMPORTANT:  The following steps must be completed in sequence before the Emergency Agent can receive event notifications:
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4. Click PC Emergency Agent Software to install the Client Emergency Agent application. The DX8000 Security Setup dialog box appears.

Figure 224.  DX8000 Security Setup Dialog Box

5. Verify that the “Install IPSec Configurations” check box is selected.

6. Click Next. The DX8000 Emergency Agent Setup dialog box appears.

Figure 225.  DX8000 Emergency Agent Setup Dialog Box

7. Click Next. The Software License Agreement dialog box appears.

Figure 226.  Emergency Agent Software License Agreement Dialog Box

8. Read the license agreement and select the “I accept this License Agreement” check box.

9. Click Next. The Select Installation Folder dialog box appears.

IMPORTANT:  IPSec is a standard security protocol used by the DX8000 Series DVR and its clients to communicate safely over a network. 
Although IPSec security can be disabled at any time, it must be enabled in order to communicate with a DX8000 server.
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Figure 227.  PC Client Select Installation Folder Dialog Box

10.  Click Next to accept the default installation folder. 

Figure 228.  PC Client Installation Finalization Dialog Box

11. Click Finish to complete the installation process.
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ENABLING IPSEC SECURITY SERVICES
In order to communicate with a networked DX8000 Series DVR, IPSec security must be enabled on your PC computer. 

To enable IPSec security services:

1. Go to Start > Manage IPSec Policy. The DX8000 IPSec Policy dialog box appears.

Figure 229.  Enabling IPSec Security for the Emergency Agent Application

2. Select the Enable DX8000 IPSec Policy check box if it is not already selected.

DISABLING IPSEC SECURITY SERVICES
To disable IPSec security services:

1. Go to Start > Manage IPSec Policy. The DX8000 IPSec Policy dialog box appears.

Figure 230.  Disabling IPSec Security for the Emergency Agent Application

2. Deselect the Enable DX8000 IPSec Policy check box.

IMPORTANT:  Disabling IPSec security services may hamper your PC’s ability to communicate with DX8000 servers. Consult your system 
administrator before disabling IPSec security.
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Before You Begin
Ensure that the following requirements have been met before starting the Emergency Agent application:

1. Make sure there is at least one active DX8000 Series DVR available on your network and your PC computer is set up to access it. Consult 
your network administrator for more information.

2. Install the DX8000 Emergency Agent application on your PC computer if you have not done so already. Refer to Installing the Client 
Emergency Agent Application on page 173 for instructions.

3. Make sure that Emergency Agent notification is set up on one or more DX8000 Series DVRs, and that your PC has been selected to receive 
emergency notifications. Refer to the Operation and Programming Manual for more information.

4. Make sure IPSec security services are installed and enabled on your PC. Refer to Installing the Client Emergency Agent Application on 
page 173 and Enabling IPSec Security Services on page 176 for more information.
C626M-B (3/05) 177DX8000 Emergency Agent



STARTING THE CLIENT EMERGENCY AGENT
To start the emergency agent software on a client PC:

1. Turn on your PC and wait while Windows loads.

2. Double-click the Emergency Agent icon on the client computer’s desktop.

CLIENT EMERGENCY AGENT DIALOG BOX

Figure 231.  Client Emergency Agent Dialog Box
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REAL-TIME EVENT MONITORING
Once the Client Emergency Agent has been activated, a motion or alarm event detected by a linked camera on a DX8000 server will cause a 
pop-up window to display a still image of the event. In addition to real-time monitoring of events, all event notifications sent to the client will be 
logged for future viewing.

Figure 232.  Client Emergency Agent Pop-up Window

SETTING THE CLIENT EMERGENCY AGENT LISTEN PORT
If necessary, you can change the network port used by the Client Emergency Agent.

To change the port:

1. Click the Port Setting button. The Emergency Agent Listen Port dialog box opens.

Figure 233.  Emergency Agent Listen Port Dialog Box

2. If necessary enter a new port number (default port number is 9004).

3. Click OK.

IMPORTANT:  The port number must be an integer between 5000 and 6535. You should keep the default port setting of 9004 unless there 
is a conflict on your network. Consult your network administrator before changing network port settings.
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VIEWING PREVIOUSLY LOGGED EVENTS
Over time, the Client Emergency Agent will accumulate event information in a list. This list can be searched and still images of previously logged 
events can be viewed.

To view previously logged events:

1. Select a DX8000 Series DVR from the Server list.

2. Select a start date to mark the first date to begin searching logged events.

3. Select an end date to make the last date to search for logged events.

4. Select the type of event (motion and/or alarm) to search.

5. Select one or more cameras.

6. Double-click each event in the event list you want to view. A pop-up window containing a still image of the logged event will display.

Figure 234.  Client Emergency Agent Server List and Log

NOTE:  Setting the start time earlier than the first time you began using the Client Emergency Agent will result in no events appearing in 
the list.

	
�

�

�
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Figure 235.  Client Emergency Agent Pop-up Window

SHUTTING DOWN THE CLIENT EMERGENCY AGENT
To shut down the Client Emergency Agent, click Quit.
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DX8000 Native Viewer Application

Setting Up and Using the DX8000 Native Viewer

DESCRIPTION
The DX8000 Native Viewer is capable of playing back a variety of video, still image, and audio media formats. It is designed to recognize and 
verify the digital watermark that is embedded in DX8000 native video. Watermarking is used to authenticate the originality of a video file and to 
alert users of possible image tampering. The viewer application runs automatically each time a CD or DVD created by the DX8000’s export 
feature is inserted into a Windows-based PC. The software can also be installed on a PC and opened independently when necessary.

RECOMMENDED SYSTEM REQUIREMENTS
• Minimum recommended system requirements for the DX8000 PC Client, Emergency Agent, and Native Viewer software applications 

include

• Processor: Intel® Pentium® III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB of video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX® 8.1 or later hardware 
acceleration

• 500 MB of free disk space

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows® 2000 (SP4) or Windows XP only

DX8000 VIEWER SOFTWARE INSTALLATION
1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8000 Resource CD into the CD-ROM drive of your PC and wait for the DX8000 Resource CD screen to appear.
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Figure 236.  Resource CD Screen: Native Viewer Option

4. Click Native Viewer to install the viewer application, and then follow the directions on the screen.

STARTING THE DX8000 NATIVE VIEWER
To start the DX8000 Native Viewer software on a client PC:

1. Turn on the client computer and wait while Windows loads.

2. Double-click the DX8000 Native Viewer icon on the client computer’s desktop.
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SCREEN LAYOUT

Figure 237.  DX8000 Native Viewer Main Screen

	 Toolbar

� View panel

� Playback controls

� Playback slider

� Volume controls (click speaker icon to toggle audio mute)

� Watermark verification message area

TOOLBAR ICONS

  Browse drives and open media files.

  Save a snapshot of the current screen image.

  Print the current screen image.

  Expand window to reveal playlist.

  Expand the window to reveal configuration tools.

	

�

�

� ��
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VIEWING MEDIA FILES
To open a file for viewing: 

1. Click . The Open dialog box appears.

Figure 238.  Open Dialog Box

2. Click the “Look in” drop-down box to select the drive and folder location where the media file(s) resides.

3. Select the file(s) you want to play.

4. Click Open. 

5. The first image of the file appears in the view panel and a positive or negative watermark verification message appears in the bottom 
portion of the screen.

Figure 239.  View Panel and Watermark Message

�

�

�
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PLAYING VIDEO
You can play video files in the DX8000 viewer after they have been opened.

To begin playback of a an exported DX8000 video file:

1. Click .

2. Use the playback controls and playback slider to move through a video file.

3. Use the audio controls to increase, decrease, or mute playback volume.

SAVING SNAPSHOTS
You can take snapshots of still images that appear in the view panel. Snapshots are stored in a folder for later retrieval or viewing. Refer to the 
Working with Viewer Configuration Tools section for information on changing the location of the snapshot folder.

Click  to save a snapshot of the still image appearing on the screen.

PRINTING IMAGES
You can print still images that appear in the view panel.

Click  to print the still image appearing on the screen.

WORKING WITH THE PLAYLIST
The DX8000 viewer application allows you to create, load, and save playlists of media files.

Click  to access the playlist.

Figure 240.  Viewer Playlist

TIP:  You can use the playback controls to pause a video file on a specific still image.

TIP:  You can use the playback controls to pause a video file on a specific still image.
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To add media files to the current list:

1. Click .The Open dialog box appears.

Figure 241.  Adding Files to a Play List

2. Click the “Look in” drop-down box to select the drive and folder location where the media file(s) resides.

3. Select the file(s) you want to play.

4. Click Open.

To remove media files from the current list:

1. Select a file from the list. 

2. Click  to remove the file.

To play a file from the playlist, double click its name.

Click  to load a previously saved playlist.

Click  to save the current playlist to disk.

TIP:  Use the Ctrl key to select multiple files at one time to add to the playlist.

NOTE:  If there are multiple files in the playlist, each file will play in the order that appears in the list.

NOTE:  Depending on the amount of data stored and the type of media used, it may take several minutes to load media files and playlists.

�

�

�

Load

Save
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WORKING WITH VIEWER CONFIGURATION TOOLS
Click  to access setup features for the viewer.

Figure 242.  Viewer Configuration Tools

To adjust the picture quality in the view panel, move the sliders for the following properties:

• Brightness

• Contrast

• Hue

• Saturation

Click  to change the snapshot directory.

To exit the DX8000 viewer application, click the  icon at the top-right corner of the viewer window.

Browse

X

C626M-B (3/05) 189DX8000 Native Viewer Application





DX8000 Mobile Client Application

Setting Up and Using the DX8000 Mobile Client

DESCRIPTION
The DX8000 Mobile Client allow you to view live video remotely from multiple cameras and sites. Networking capabilities include local 
connection using wire-bound or wireless LAN technologies or remote connection using the Internet. The DX8000 Mobile Client software runs on 
a standard pocket PC-based PDA and can display a single channel of real-time video from any camera attached to any DX8000 DVR on the 
network. Features include hierarchical organization of multiple sites, built-in security through password protection, and an adjustable viewing 
area, including full-screen view.

MOBILE (PDA) CLIENT RECOMMENDED SYSTEM REQUIREMENTS
• PDA Hardware: A pocket PC-compatible handheld device. 

• Processor: Intel XScale® compatible with a minimum processor speed of 400 MHz

• Memory: 64 MB of RAM

• Video: TFT liquid crystal display with minimum 240 x 320 display resolution, 64K colors

• Operating System: Microsoft pocket PC 2002 or later

• A PC with Windows operating system and Microsoft ActiveSync® version 3.5 or later installed

• Wired or wireless networking capability

MOBILE (PDA) CLIENT SOFTWARE INSTALLATION
1. Install ActiveSync on your Windows PC if it is not already present.

2. Connect your hand-held device to your PC.

Figure 243.  PDA-to-PC Connection 

3. Turn on your handheld device if it is not already running.

PCPDA
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4. Insert the DX8000 Resource CD into the CD-ROM drive of your PC, and wait for the DX8000 Resource CD screen to appear.

Figure 244.  Resource CD Screen: Mobile Client Installation Option

5. Click Mobile Client Software. The Pocket PC installation screen appears.

Figure 245.  Pocket PC Installation Dialog Box

6. Click Next.
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7. Read and agree to the license agreement and then click Finish.

Figure 246.  Mobile Client License Agreement Dialog Box

8. When the Installing Applications dialog box appears, click Yes to accept the default installation directory. 

Figure 247.  Installing Applications Dialog Box

9. Wait while ActiveSync copies the DX8000 Mobile Client program files to your handheld device, and then click OK from the Application 
Downloading Complete dialog box.

Figure 248.  Application Downloading Complete Dialog Box
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CONNECTING MOBILE CLIENTS TO A DX8000 SERIES DVR
Using a wired or wireless network connection, the DX8000 Mobile Client application can monitor live video from a number of geographically 
dispersed DVRs. Figure 249 illustrates a simplified wireless network connecting a pocket PC-compatible PDA device to a single DX8000 DVR. 

Detailed instructions describing how to configure your particular PDA device for wireless networking is beyond the scope of this manual. Consult 
your network administrator and the documenation that came with your device for instructions on connecting your PDA to a network. 

Figure 249.  PDA-to-DVR Wireless Networking Example

NOTE:  When using wireless networking to connect a mobile device to the DX8000, Pelco recommends using enterprise class Access 
Points, transceivers, and switches. Wired networking infrastructure should comply with IEEE 802.3 Fast Ethernet standards. Wireless 
networking infrastructure should comply with IEEE 802.11a, b, or g networking standards.

WIRELESS
ACCESS POINT

ETHERNET SWITCH

MOBILE CLIENT

DX8000 SERVER DVR
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STARTING THE DX8000 MOBILE CLIENT
Before attempting to start the DX8000 Mobile Client application, make sure you have installed the Mobile Client software on your pocket 
PC-compatible handheld device and you have an active network connection to a DX8000 DVR server.

Tap Start > Programs > DX8000.

MAIN SCREEN LAYOUT

Figure 250.  Main Screen

	 View window

� Camera selection buttons

� Currently viewed camera

� Data rate

� Mobile Client frame rate

� DX8000 menu

� Live menu

� Connect

� Disconnect


� Resume live view


� Pause live view



 Switch to full-screen view

�

	

� �
�

� 
�



�

�
�
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EXITING THE DX8000 MOBILE CLIENT
1. Tap DX8000 on the toolbar.

2. Tap Exit.

Figure 251.  Exiting the Program

SECURITY SETUP

SETTING UP AN INITIAL PASSWORD:

1. Tap DX8000 > Options > Security.

Figure 252.  DX8000 Menu Security Option

TIP:  You can also Tap the  icon on the title bar to exit.
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2. Leave the Current text box blank.

3. Enter a password in the New text box. (Passwords must be between 4 and 10 characters long and can include spaces and special 
characters.)

4.  Re-enter the new password in the Confirm text box.

5. Tap OK.

Figure 253.  Entering a New Password

CHANGING AN EXISTING PASSWORD:

1. Tap DX8000 > Options > Security.

Figure 254.  Security Menu Option
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2. Enter your password in the Current text box.

3. Enter a different password in the New text box. (Passwords must be between 4 and 10 characters long and can include spaces and special 
characters.)

4. Re-enter the new password in the Confirm text box.

5. Tap OK.

Figure 255.  Changing a Password

LOGGING IN TO THE MOBILE CLIENT APPLICATION
After the security password has been assigned, you must log in to the Mobile Client application each time it is launched.

To log in to the Mobile Client application, enter a password in the field provided and then click OK.

Figure 256.  Mobile Client Log In Prompt
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WORKING WITH SITES AND GROUPS

CREATING SITE GROUPS

1. Tap  on the toolbar to take you directly to the Connect screen.

Figure 257.  Connect Menu Option

2. Tap Add.

Figure 258.  DX8000 Groups and Sites

TIP:  You can also Tap DX8000 > Connect to go to the Connect screen.
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3. Tap New Group.

Figure 259.  Creating a New Group

4. Enter a name for the new group. (Group names can be a maximum of 15 characters long and can include spaces and special characters.)

5. Tap OK.

Figure 260.  Group Name Text Box

6. Tap Cancel to return to the Connect screen.

Figure 261.  Finalize New Group Creation
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EDITING AN EXISTING GROUP

1. Tap .

2. Select the group you wish to edit.

3. Tap Edit.

Figure 262.  Editing a Group

4. Enter a new group name.

5. Tap OK.

Figure 263.  Editing Group Information 

6. Tap Close to return to the main screen.
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DELETING A GROUP

1. Tap the  icon on the toolbar.

2. Select the group you wish to delete.

3. Tap Del.

Figure 264.  Deleting a Group

4. Select an option to either delete or retain sites within the group to be deleted.

• Select Moved into Default Group to move any sites to the Remote Site group.

• Select Deleted to delete the group and any sites contained within it.

5. Tap OK to complete the deletion process for the group.

Figure 265.  Finalizing Group Deletion

6. Tap Close to return to the main screen.

NOTE:  You cannot delete the Remote Site group.
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ADDING A DX8000 SITE TO A GROUP

1. Tap .

2. Tap Add.

Figure 266.  Adding a New DX8000 Site

3. Select a Group from the drop-down box.

Figure 267.  Site Setup Screen
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4. Enter a name for the new DX8000 site. (Site names can be a maximum of 15 characters; spaces and special characters are allowed.)

5. Enter the IP address of the new site. 

6. If necessary enter a new base port number (9002 is the default).

7. Tap OK.

Figure 268.  Entering New Site Information

8. Tap Connect to connect to the newly created site, or tap Close to go back to the main screen.

Figure 269.  New Site in Connect Window

NOTE:  Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, 
but are protected from external threats by a firewall. Mobile client and server ports must be identical.
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EDITING A DX8000 SITE

1. Tap the  icon on the toolbar.

2. If necessary, tap the plus (+) sign next to the group name to expand it.

3. Select the DX8000 DVR you want to edit.

4. Tap Edit.

Figure 270.  Selecting a Site to Edit

5. Enter a new name for the site.

6. Enter a new IP address for the site.

7. If necessary enter a new base port number (9002 is the default).

8. Tap OK.

Figure 271.  Changing a Site’s Name and IP Address

9. Tap Close to return to the main screen.

NOTE:  Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, 
but are protected from external threats by a firewall. Web client and server ports must be identical.
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DELETING A DX8000 SITE

1. Tap the  icon on the toolbar.

2. If necessary, tap the plus (+) sign next to the group name to expand it.

3. Select the DX8000 DVR Site you wish to delete.

4. Tap Del.

Figure 272.  Deleting a Site

5. Tap Close to return to the main screen.
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CONNECTING TO A DX8000 SITE

1. Tap the  icon on the toolbar.

2. If necessary, tap the plus (+) sign next to the group name to expand it.

3. Select the DX8000 DVR you wish to connect to.

4. Tap Connect to connect to the remote site and return to the main screen.

Figure 273.  Connecting to a DVR Site

DISCONNECTING FROM A SERVER SITE
1. Tap DX8000 on the toolbar.

2. Tap Close.

Figure 274.  Disconnecting from a Site

TIP:  Tapping the  icon on the title bar will disconnect the site.
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VIEWING LIVE VIDEO
Once you have connected to a DX8000 site, the main screen displays a live image from Camera 1 of the connected site. Figure 275  illustrates 
live view from the main screen.

1. Tap one of the camera selection buttons to view live video from a different camera.

2. Tap the  to pause the image.

3. Tap the  to resume live view.

Figure 275.  Viewing Live Video from the Main Screen

Figure 276.  Live Menu with Start and Stop Options

TIP:  You can pause an image and resume live view by choosing menu commands as well. Tap Live > Stop to pause and Live > Start to 
resume live viewing.
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CUSTOMIZING THE VIEW SCREEN

CHANGING SCREEN SIZE

To change the size of the main screen viewing area:

1. Tap DX8000 > Options > View Size.

Figure 277.  DX8000 Menu and View Size Option
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2. Deselect the Auto Fit check box.

3. Move the slider to the desired position. (Screen size ranges from 120 x 90 to 240 x 180 pixels).

4. Tap OK.

Figure 278.  Minimum Screen Size

.

Figure 279.  Medium Screen Size Figure 280.  Maximum Screen Size

�
�

�
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FULL-SCREEN MODE

To change to full-screen view:

1. Tap .

Figure 281.  Full-Screen View

2. Tap anywhere on the screen to exit full-screen view.

Figure 282.  Live Menu and Full-Screen Option

TIP:  You can also tap Live > Full Screen to change to full-screen view.
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DX8000 Web Client

Using the DX8000 Web Client

DESCRIPTION
The DX8000 Web Client allows you to view live video and operate PTZ features of cameras attached to DX8000 Series DVRs. Using a standard 
web browser, you can remotely monitor up to 16 cameras from up to five DX8000 servers simultaneously. Each DX8000 DVR can support up to 
100 web clients either internally within an organization or externally through the Internet. 

Features:

• Live viewing of up to 16 cameras simultaneously

• Ability to monitor cameras from multiple DX8000 sites

• Multiple screen division options, including single, quad, and sixteen panel views

• Full PTZ control

• Runs on multiple platforms using a standard web browser 

SYSTEM REQUIREMENTS
• Minimum recommended system requirements for the DX8000 Web Client include

• Processor: Intel Pentium III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX 8.1 or later hardware 
acceleration 

• 500 MB of free disk space

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows 2000 (SP4) or Windows XP only

NOTE:  The DX8000 web client is not compatible with Netscape® Navigator.
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INSTALLATION
The first time you use a web browser to connect to a DVR server, an ActiveX® control application is downloaded and installed on your local 
computer. This control facilitates usage of the web client’s interactive features.

To install the DX8000 Web Client application:

1. Start Microsoft Internet Explorer web browser.

2. Enter the IP address of one of the DX8000 servers you want to connect to in the address bar. The Enter Network Password dialog box 
appears.

Figure 283.  Enter Network Password Dialog Box

3. Click OK. The DX8000 Video Recorder dialog box opens.

NOTE:  The DX8000 Web Client application is not compatible with Netscape Navigator.

�
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Figure 284.  ActiveX Control Installation Dialog Box

4. Click Yes. 

5. Wait while the ActiveX controls are downloaded to your PC and your browser software is updated.

6. Install and enable IPSec security services. Refer to either Installing the PC Client Application on page 13 or Installing the Client Emergency 
Agent Application on page 173 for instructions on installing IPSec security services. Refer to Enabling IPSec Security Services on page 176 
for instructions on how to enable IPSec security services.

STARTING THE DX8000 WEB CLIENT
To activate the DX8000 Web Client application:

1. Start Microsoft Internet Explorer.

2.  Enter the IP address of one of the DX8000 servers you wish to connect to in the address bar. The Digital Video Recorder dialog box opens.

NOTE:  You must install either the PC Client application or the Client Emergency Agent application to install IPSec security services.

NOTE:  Your Web browser must have cookies enabled. Refer to Microsoft Internet Explorer Help for instructions on enabling cookies.

IMPORTANT:  To avoid potential problems and conflicts within your computer’s video subsystem, run only one instance of the PC Client 
application or Web Client at a time. You must have IPSec security services enabled to use the DX8000 Web Client.
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Figure 285.  Entering a DX8000 Server User Name and Password

3. Enter a DX8000 server user name.

4. Enter the DX8000 server password.

5. Click OK. The DX8000 Web Client screen appears.

NOTE:  User names and passwords are case sensitive; type them exactly as shown.
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SCREEN LAYOUT
Cameras can be assigned to view panels, live video can be displayed, and PTZ features can be controlled from a single screen. 
Figure 286 can be used to locate each available feature of the DX8000 Web Client application.

Figure 286.  Web Client Screen Layout

	 Site tree

� Screen division buttons

� Remote site connection button

� PTZ zoom control

� PTZ focus control

� PTZ iris control

� PTZ keypad

� View panels display live video from cameras attached to DX8000 server sites

	

� �

�

�

�

�

�
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WEB CLIENT CONFIGURATION

ADDING DX8000 DVR SERVERS TO THE CONNECTION LIST

Before live video can be viewed from the Web Client’s view panels, at least one connection to a remote DX8000 server must be established. 
Up to fifty DX8000 server sites can be added to the Connection List; however, each server is limited to five incoming user connections.

ADDING A DX8000 DVR SERVER TO THE CONNECTION LIST
To add a site to the Connection List when you know the site’s IP address:

1. Click . The Connection List dialog box opens.

Figure 287.  Connection List Dialog Box

2. Click Add. The Server Information dialog box appears.

Figure 288.  Server Information Dialog Box

�
�
�
�

�
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3. Enter the name of the DX8000 Series DVR you wish to connect to.

4. Enter the IP address of the DVR.

5. If necessary enter a new base port number (9002 is the default).

6. If necessary enter a software upgrade port number (9003 is the default).

7. Click OK. The site appears in the Connection List.

To add a remote DVR site to the Connection List when you do not know the IP address of the site:

1. Click . The Connection List dialog box opens.

Figure 289.  Connection List Dialog Box

NOTE:  Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, 
but are protected from external threats by a firewall. Web client and server ports must be identical.

NOTE:  To be successful, the following stipulations must be satisfied:

• Each DVR must be attached to the same subnet.

• The first three octets of the IP address of the subnet must be known.

• The range of addresses used in the last octet of the subnet must be known.
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2. Click DX8000 Scan. The DX8000 Scan dialog box appears.

Figure 290.  DX8000 Scan Dialog Box

3. Enter an IP address range to search for DVR sites.

a. Enter the first three octets of the IP range you wish to search; for example, 10.10.1.

b. Enter the beginning value for the search range in the fourth octet; for example, 001.

c. Enter the final value for the search range in the text box provided; for example, 254.

4. Click Find.

5. Select one or more DX8000 servers to add to the site tree.

6. Click Add. The site appears in the Connection List.

7. Click OK when you return to the Connection List dialog box.

NOTE:  Each octet of the IP address must be an integer between 1 and 255.

�

�

�

3a 3b 3c
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DELETING A DX8000 DVR SERVER FROM THE CONNECTION LIST

1. Click . The Connection List dialog box opens.

Figure 291.  Deleting a Site from the Connection List

2. Select the DX8000 Series DVR you wish to delete.

3. Click Delete. The site disappears from the Connection List.

4. Click OK.

�

�

�
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EDITING A DX8000 SERVER’S INFORMATION IN THE CONNECTION LIST

1. Click . The Connection List dialog box opens.

Figure 292.  Editing a Site from the Connection List

2. Select the DX8000 Series DVR you wish to edit.

3. Click Edit. The Server Information dialog box appears.

Figure 293.  Editing Server Information

4. Enter a new name for the server.

5. Enter a new IP address for the server.

6. If necessary enter a new base port number (9002 is the default).

7. If necessary enter a software upgrade port number (9003 is the default).

8. Click OK. The site appears in the Connection List.

9. Click OK when you return to the Connection List dialog box.

NOTE:  Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, 
but are protected from external threats by a firewall. Web client and server ports must be identical.

�

� �

�
�
�
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CONFIGURING VIEW PANELS
The DX8000 Web Client can display up to sixteen cameras simultaneously on a single screen.

To establish the arrangement of view panels on the Web Client screen, select a screen division button from the toolbar.

CONNECTING TO A REMOTE SITE
To connect to an active DX8000 server on the network:

1. Right-click the remote site name from the site tree.

2. Select Connect from the quick-menu.

Figure 294.  Remote Site Connect Quick-Menu

Displays one camera. Six-panel display. Divides screen into one large and five 
small view panels.

Displays four cameras at a time (quad display). Ten-panel display. Divides screen into two large and 
eight small view panels.

Displays nine cameras at a time. Thirteen-panel display. Divides screen into one large and 
twelve small view panels.

Displays 16 cameras at a time.
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LOGGING IN TO A REMOTE SITE
After a connection to a remote site has been established, you must log in with a valid user name and password for that site. 

To log in to a remote site:

1. Select a remote DX8000 Series DVR site from the site tree.

Figure 295.  Selecting a Site

2. Right-click the site name and then select User Log-in from the quick-menu.

3. Enter a user name and password for the remote site.

Figure 296.  User Log-In Dialog Box

LOGGING OUT OF A REMOTE SITE
To log out of a remote DVR site, right-click the site name from the site tree and select User Log-Out from the quick-menu. 
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DISCONNECTING FROM A REMOTE SITE
To terminate a connection with a remote DX8000 server:

1. Right-click the name of the remote site from the site tree.

2. Select Disconnect from the quick-menu.

Figure 297.  Quick-Menu Disconnect Option

ASSIGNING CAMERAS TO VIEW PANELS
The DX8000 Web Client includes up to 16 view panels. Each view panel can display a single camera channel from any connected server.

To assign a camera to a view panel:

1. Click the plus sign (+) next to the word “Camera” on the site you wish to view. This expands the site tree. 

2. Drag a camera from the site tree onto a view panel.

Figure 298.  Dragging a Camera to a Web Client View Panel

3. Repeat the process in steps 1-3 for up to 16 cameras from various DVR sites.

NOTE:  When changing from one screen division to another you must reassign cameras to view panels.

	

�
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VIEWING LIVE VIDEO
To view live video from up to sixteen cameras, drag one or more cameras from the site tree onto the view panels. Refer to Assigning Cameras to 
View Panels on page 32 for instructions.

OPERATING THE ON-SCREEN PAN, TILT, AND ZOOM (PTZ) CONTROLS

The on-screen PTZ control allows users to manipulate the positioning and lens features of cameras using a mouse.

To operate the on-screen PTZ controls:

1. Place the mouse pointer in the middle of a camera view panel.

Figure 299.  Web Client On-Screen PTZ

2. Click the left mouse button, and then drag the mouse pointer in the direction you wish to move the camera. Figure 300 illustrates the range 
of motion possibilities for the on-screen PTZ control.

Figure 300.  On-Screen PTZ Movement

3. Release the mouse button when you have moved the camera to the desired position.
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4. To adjust camera lens features, click plus (+) or minus (−) buttons next to each function on the keypad. Refer to Figure 301.

Figure 301.  Web Client PTZ Lens Controls

5. To adjust camera zoom using the mouse, rotate the mouse wheel forward to zoom in and backward to zoom out.

Figure 302.  Web Client Mouse Wheel Zoom

�
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PTZ PRESETS
A preset is a user-defined camera position using pan and tilt, zoom, and focus commands.  A DX8000 Series DVR can address up to 32 PTZ 
presets (1-32).  Preset 95 is reserved for remote camera setup, and preset 99 is reserved for camera autoscan mode.

PROGRAMMING A PRESET

To program a PTZ preset:

1. Drag a camera from the site tree onto a view panel.

2. Click .

Figure 303.  Web View and PTZ Control Panel

NOTE:  Only cameras that support positioning and programming using D, P, or Coaxitron protocols can use this feature.

IMPORTANT:  To program or clear presets, preset tours, and patterns, the  icon must be engaged.  To activate presets, tours, and 

patterns, the  icon must be disengaged.

TIP:  Clicking the  icon places DX8000 in PTZ programming mode. While in PTZ programming mode, multiple presets 

can be programmed until the  icon is pressed again.
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3. Using the on-screen PTZ controls and PTZ keypad, move the camera to the desired position and adjust zoom and iris settings.

Figure 304.  Moving to a Preset Using Web Client

4. Using the PTZ keypad, select a number for the new preset (for example, 1).

Figure 305.  Programming a Preset Using Web Client

5. Click  to store the preset in the selected memory location.

6. Repeat steps 4-6 for each preset you want to program.

7. Click  again to exit programming mode.

EXIT

�

�

�
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ACTIVATING A PRESET

To activate a preset:

8. Click a preset number (1-32) on the keypad.

9. Click  to activate preset. The camera repositions to the new preset.

Figure 306.  Activating a Preset Using Web Client

CLEARING A PRESET

To clear a preset:

1. Click  to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click  to exit programming mode.

Figure 307.  Clearing a Preset Using Web Client

TIP:  Double-digit presets can be set or activated by pressing the first digit and then the second digit sequentially. For example, preset 20 
can be selected by clicking the number 2 and then the number 0 on the PTZ keypad.

	

�

	

�
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PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a definite beginning and end. Patterns are made up of a sequence of standard pan, tilt, 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra dome, that is connected to the DX8000. 
Depending on the type and configuration of the PTZ device, the DX8000 can address up to four unique PTZ patterns. Once defined, a pattern can 
be activated with a series of on-screen commands. A pattern will run continuously until it is deactivated. 

PROGRAMMING A PATTERN

To program a pattern:

1. Drag a camera from the site tree onto a view panel.

2. Click  to enter programming mode.

3. Using the PTZ keypad, select a number for the pattern (1 to 4).

4. Click .

5. Move the camera through a series of movements using the on-screen pan and tilt, zoom, and focus controls.

Figure 308.  Programming a Pattern Using Web Client

To stop programming a pattern:

1. Click .

2. Click .

NOTE:  Only PTZ-enabled cameras that support pattern programming through D, P, or Coaxitron protocols can use this feature.

NOTE:  Certain PTZ devices, like Pelco’s Spectra series domes, will display an on-screen message stating the amount of remaining memory 
available for pattern programming.

�

�

�
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ACTIVATING A PATTERN

To activate a pattern:

1. Click a pattern number (1 to 4) on the keypad.

2. Click .

Figure 309.  Activating a Pattern Using Web Client

CLEARING A PATTERN

To clear a pattern:

1. Click  to enter programming mode.

2. Select a pattern number (1 to 4) on the keypad.

3. Click .

4. Click .

5. Click  again.

6. Click  again to exit programming mode.

Figure 310.  Clearing a Pattern Using Web Client

IMPORTANT:  A pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

	

�

�

	

�
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ACCESSING PROGRAMMING FEATURES OF REMOTE CAMERAS

You can use the PTZ function to program features of remote cameras, such as Pelco’s Spectra III.

To access a programming menu for a remote camera:

1. Drag a camera from the site tree onto a view panel.

Figure 311.  Web Client View Panels

2. Click  from the keypad to access remote camera setup mode.

Figure 312.  PTZ Control Panel Using Web Client

NOTE:  Only cameras that support remote programming through D, P, or Coaxitron protocols can use this feature.

TIP:  For certain camera models, you can also select preset number 95 from the keypad to access remote setup mode. 

To access preset number 95, click , 9, 5, and  from the PTZ keypad.
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3. Use the on-screen PTZ controls or the focus (+) and focus (−) buttons to navigate up and down camera menu choices.

Figure 313.  Camera Setup Menu

4. Click the iris (+) button to select an option from the camera’s on-screen menu.

5. Click the iris (−) button to cancel an option or exit a menu.

EXITING THE DX8000 WEB CLIENT
To exit the Web Client application, select File > Close from the browser window.

Figure 314.  Web Browser File Menu

TIP:  You can also use the on-screen PTZ controls with your mouse to navigate camera menus. Click and drag the mouse up or down to 
move between menu options and then select the option using the iris (+) button.
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PRODUCT WARRANTY AND RETURN INFORMATION

 

WARRANTY

 

Pelco will repair or replace, without charge, any merchandise proved defective in
material or workmanship 

 

for a period of one year 

 

after the date of shipment. 

Exceptions to this warranty are as noted below:

• Five years on FT/FR8000 Series fiber optic products and the following fixed
camera models: CC3701H-2, CC3701H-2X, CC3751H-2, CC3651H-2X,
MC3651H-2, and CC3651H-2X.

• Three years on all other fixed camera models (including Camclosure

 

®

 

 Integrated
Camera Systems) and Genex

 

®

 

 Series (multiplexers, server, and keyboard).

• Two years on all standard motorized or fixed focal length lenses.

• Two years on Legacy

 

®

 

, CM6700/CM6800/CM8500/CM9500/CM9700 Series
Matrix, DF5 and DF8 Series Fixed Dome products.

• Two years on Spectra

 

®

 

, Esprit

 

®

 

, and PS20 Scanners, including when used in
continuous motion applications.

• Two years on Esprit

 

®

 

 and WW5700 Series window wiper (excluding wiper
blades).

• Eighteen months on DX Series digital video recorders and NVR300 Series
network video recorders.

• One year (except video heads) on video cassette recorders (VCRs). Video heads
will be covered for a period of six months.

• Six months on all pan and tilts, scanners or preset lenses used in continuous
motion applications (that is, preset scan, tour and auto scan modes).

Pelco will warrant all replacement parts and repairs for 90 days from the date of
Pelco shipment. All goods requiring warranty repair shall be sent freight prepaid to
Pelco, Clovis, California. Repairs made necessary by reason of misuse, alteration,
normal wear, or accident are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss result-
ing from the specific use or application made of the Products. Pelco’s liability for
any claim, whether based on breach of contract, negligence, infringement of any
rights of any party or product liability, relating to the Products shall not exceed the
price paid by the Dealer to Pelco for such Products. In no event will Pelco be liable
for any special, incidental or consequential damages (including loss of use, loss of
profit and claims of third parties) however caused, whether by the negligence of
Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may
also have additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the
following information:

1. Model and serial number
2. Date of shipment, P.O. number, Sales Order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product which does not fall under
the warranty conditions stated above, please include a written explanation with
the product when returned.

Method of return shipment shall be the same or equal to the method by which the
item was received by Pelco.

 

RETURNS

 

In order to expedite parts returned to the factory for repair or credit, please call the
factory at (800) 289-9100 or (559) 292-1981 to obtain an authorization number (CA
number if returned for credit, and RA number if returned for repair).

All merchandise returned for credit may be subject to a 20% restocking and refur-
bishing charge.

Goods returned for repair or credit should be clearly identified with the assigned
CA or RA number and freight should be prepaid. Ship to the appropriate address
below.

 

If you are located within the continental U.S., Alaska, Hawaii or Puerto Rico, send
goods to:

 

Service Department
Pelco
3500 Pelco Way
Clovis, CA 93612-5699

 

If you are located outside the continental U.S., Alaska, Hawaii or Puerto Rico and
are instructed to return goods to the USA, you may do one of the following:

 

If the goods are to be sent by a COURIER SERVICE, send the goods to:
Pelco
3500 Pelco Way
Clovis, CA 93612-5699 USA

If the goods are to be sent by a FREIGHT FORWARDER, send the goods to:
Pelco c/o Expeditors
473 Eccles Avenue
South San Francisco, CA 94080 USA

Phone: 650-737-1700

Pelco, the Pelco Logo, Spectra, Genex, Legacy, Esprit, Camclosure, and Coaxitron are registered trademarks of Pelco.
Microsoft, Windows, DirectDraw, DirectX, ActiveSync, and ActiveX are registered trademarks of Microsoft Corporation. 

Intel, Pentium, and XScale are registered trademarks of Intel Corporation.
Netscape is a registered trademark of the Netscape Communications Corporation.

Spectra III is a trademark of Pelco.
© Copyright 2005, Pelco. All rights reserved.

REVISION HISTORY

Manual # Date Comments
C626M 3/04 Original version.
C626M-A 12/04 Added information about cursor control keys, export function, enabling/disabling instant record, multilanguage support, and backup feature.
C626M-B 3/05 Revised the web client installation procedure.
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